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PREFACE 

 

The M.A. Thesis Manual has been compiled for students in the Oral Roberts University 

Graduate School of Theology and Ministry (GSTM) Seminary. This manual supplements Kate 

L. Turabian’s form and style manual, A Manual for Writers of Term Papers, Theses and Disser-

tations (7th edition), officially adopted by STM.  Nancy J. Vyhmeister’s book, Quality Research 

Papers, based on Kate Turabian’s work, has also been a resource for this manual.  

 This manual has been designed, first of all, to provide specific introductory matter for 

the M.A. Thesis. Second, it outlines general form and style requirements and other require-

ments, along with examples.  Third, it describes and illustrates the process of formatting Thesis 

documents. Fourth, it provides bibliographic and footnote examples that are not explicit either in 

Turabian or Vyhmeister.  Fifth, it lists abbreviations of books of the Bible, scholarly abbrevia-

tions, and Greek and Hebrew text Citations. Finally, it lists the ORU Library Resources, and 

describes and illustrates the procedures for accessing these resources.   
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(GSTM) are pleased to provide this M.A. Thesis Manual to assist M.A. students with their re-

spective writing projects. Dr. Cheryl Iverson has provided oversight for this manual, and she 

extends her gratitude and appreciate to several individuals: Dr. Thomson K. Mathew, the GSTM 

Dean, who has supported this project and provided the necessary resources to bring it to comple-

tion. She is also grateful for the valuable contributions made by Dr. Mark Hall, Sally Shelton, 

and Dr. David Hebert.  Jake Davis, M.A., M.Div.; Melissa Miller, M.A., M.Div.; and Marlene 

Mankins, M.A. These assistants have demonstrated their dedication, academic excellence,          

technical skills and organizational ability. They know this form and style manual will be a          

valuable resource for students in the completion of their respective degrees. 

 

 

Cheryl L. Iverson, Ph.D., Associate Dean of Academic Affairs 
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OVERVIEW: THESIS RESEARCH AND WRITING 
 

Goals:  Upon successful completion of this course, the student will be able to perform 

the following: 

Demonstrate the will and tenacity to complete a scholarly research project 

Show the ability to follow proper research methodology 

Demonstrate the ability to organize and interpret material in a particular degree area 

Make an original and/or supportive scholarly contribution 

Demonstrate a scholarly writing style 

The M.A. Thesis Research and Writing courses provide the opportunity for stu-

dents to utilize and integrate knowledge of theological and hermeneutical perspectives, 

methodological tools, languages, research skills, and socio-historical information in the 

chosen discipline in order to produce an academic study demonstrating competency in 

one specialized aspect of a topic in the area of the student’s concentration.  The courses 

allow students the opportunity to conduct research in a specific area and organize and 

present the results of the research in a systematic way.  Each student has a faculty advi-

sor to guide him or her in the researching and writing of the thesis.  The thesis does not 

necessarily require the student to contribute new or unique insights or positions concern-

ing the topic, but to show mastery of existing resources and knowledge in one aspect of 

the discipline.   

It is highly recommended that you complete the Thesis Writing course the          

semester before you graduate.  For example, if you plan to graduate in May, the thesis 

should be completed by the previous December.  In order to reach this goal, you would 

need to complete the Thesis Research course during the spring. 

 

Course Calendar 

First Semester:  GBIB/GTHE 756 Thesis Research (taken the year before the May 

graduation) Write a thesis proposal as outlined below. 

Week 1-3: Meet with thesis supervisor; discuss potential research topics and re-

search methods 

Weeks 4-9: Gather and organize information for the thesis, review of literature, bib-

liography, proposal, and abstract 

Weeks 10-12: Write abstract, proposal, bibliography, review of literature, and outline 

of the thesis 

Weeks 13-15: Review of material with thesis supervisor and faculty reader 

 

Second Semester:  GBIB/GTHE 757 Thesis Writing (taken during the first semester of 

the academic year of graduation):  Write and defend the thesis, submit required copies, 

and complete all requirements (two credits of the three-credit course). 

Weeks 1-8: Upon completion of each section of the thesis, the student must submit a 

copy to the thesis supervisor and faculty reader for analysis.   
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The thesis supervisor and faculty reader, in consultation with the student, sets deadlines 

for the submission of each section and the revisions. 

Weeks 9-10:  The student defends the thesis before the thesis supervisor and faculty 

reader.  The supervisor and reader may choose to offer suggestions and 

corrections.  The student makes the recommended changes. 

Week 11: One month prior to the date of graduation (or one month before the end 

of the semester, if the thesis is completed in the fall semester), the stu-

dent presents a properly edited and corrected final copy of the thesis in a 

clamp folder and a 150-word abstract to the thesis supervisor.  The thesis 

supervisor then submits it to the faculty reader for grading.  The faculty 

reader submits the thesis and grade to the thesis supervisor who arranges 

for the form and style reader to review the thesis for conformity to cor-

rect form and style.   

Week 12:          Submit two copies of the revised thesis on 100% cotton paper. 

  

GBIB/GTHE 758 Thesis Extension:  In extenuating circumstances, students may peti-

tion for an extension to complete the thesis. If granted, the student must pay the required 

thesis extension fee of one credit hour. 

 

Required Texts 

Master of Arts Thesis Manual. Tulsa, OK: ORU, latest edition. 
 

Pazmino, Robert W. Doing Theological Research. Eugene, OR: Wipf and Stock                

 Publishers, 2009. ISBN: 9781606089392 

 

Turabian, Kate. A Manual for Writers of Research Papers, Theses, and      

            Dissertations.  7th ed.  Rev. by Wayne C. Booth, Gregory G. Colomb, and  

Joseph M. Williams.  Chicago:  University of Chicago Press, 2007. ISBN:  

9780226823379 
 

Note:  This manual, in conjunction with any additional supplements produced by 

the GSTM, constitutes the official writing form and style to be used in preparing 

the Master of Arts Thesis. 

 

Vyhmeister, Nancy Jean.  Quality Research Papers for Students of Religion and    

           Theology: Your Indispensable Guide to Writing. 2nd. ed. Grand Rapids:       

           Zondervan, 2008.  ISBN:  9780310274407 

 

Yaghjian, Lucretia, B., Writing Theology Well: A Rhetoric for Theological and Biblical  

           Writers (paperback). London: Continuum, 2006.  ISBN: 9780826418852 
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Recommended Texts: 

 

Alexander, Patrick H. et al., eds. The SBL Handbook of Style: For Ancient Near  

Eastern, Biblical, and Early Christian Studies. Peabody, MA: Hendrickson,  

1999.  ISBN: 978-1565634879 
 

Bauer, David R. An Annotated Guide to Biblical Resources for Ministry.  

            Peabody, MA: Hendrickson, 2003. ISBN: 9781565637238      
 

Glynn, John.  Commentary and Reference Survey:  A Comprehensive Guide to  

            Biblical and Theological Resources. 10th ed.  Grand Rapids:  Kregel  

            Publications, 2007. ISBN:  978-0825427374     
 

Hudson, Robert, ed.  The Christian Writer’s Manual of Style. Grand Rapids:  

            Zondervan, 2004. ISBN: 978-0310487715 
 

The Chicago Manual of Style (CMS). 16th ed.  Chicago: University of Chicago Press,  

            2010.  ISBN: 978-0226104201 
 

Yaghjian, Lucretia, B., Writing Theology Well: A Rhetoric for Theological and Biblical  

            Writers (paperback). London: Continuum, 2006.  ISBN: 9780826418852 
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GBIB/GTHE 756 THESIS RESEARCH AND PROPOSAL 

 

 

Choosing a Thesis Topic 

A thesis topic must spring from your own energies and interests.  The first step 

toward defining a topic is to determine your primary areas of interest.  The role of self-

examination in this process is critical. 

You can begin by looking over your past work in the Graduate School of          

Theology and Ministry program, especially noting your field of interest.  What courses 

have you taken?  What have you written about in course papers?  Also, think about why 

you decided to concentrate on your particular program.  As you consider these and other 

similar questions, you will begin to discern certain patterns or trends in your work.  

Contemplation of these issues will allow you to define your general areas of interest. 

Since your thesis will occupy a large portion of your time in the next few 

months, it is imperative that you choose a topic that is interesting and intriguing to you.  

Being interested in your topic will also improve the quality of your work.  The last thing 

you need is to be bored by your thesis.  

Finding a topic within an area of interest is more difficult.  A topic is best formu-

lated as a question.  But the questions cannot be too broad, for a topic must have focus.  

Nor can it be too narrow, since the goal of a good thesis is to express thoughts of general 

importance through detailed analysis of a specific subject. 

Because the purpose of this process is to formulate a focused and thought-

provoking question, the best way to uncover topics in your area of interest is to begin 

posing questions.  Start with the issues that stand out in your mind.  Also, read some 

scholarly literature on approaches you might take.  If your topic seems too broad or too 

narrow, refer to Vyhmeister (pp. 29-34) for further ideas on approaches you might take.   

The selection of a topic for a thesis must be made in close communication with 

your thesis supervisor; however, the final choice of the topic is your responsibility.  Be-

fore seeing the professor about a topic, complete the initial pre-research and write down 

two or three possible topics.  Your professor can help you to focus on the particular area 

of research.  

 

Writing the Thesis Proposal 

The following information has been adapted from Quality Research Papers, 2nd ed. by 

Nancy J. Vyhmeister.  For further explanation of the process of proposal writing, see 

pages 39-44 and 213-215 in her book . A thesis proposal provides a clear guide for the  

“Research is creating new knowledge.”  —Neil Armstrong 
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research process; it also becomes the basis for the introduction to your thesis. The pro-

posal should be between 8-10 double spaced pages (excluding bibliography). The whole 

proposal is dedicated to an explanation of what the thesis will contain.  The major parts 

of the thesis proposal are listed below: 
 

Major Parts of the Thesis Proposal: 
Be sure the final proposal follows the outline below precisely.   

Title Page 
1. Abstract: An abstract is a concise summary (approx. 150 words) of the thesis,          

intended to inform prospective readers about its content. 

2. Outline/Table of Contents:  The outline is the backbone of the thesis. It provides 

the basis for organization of the research report and the table of contents. The outline 

should be done in close cooperation with the advisor. (See example in this manual.) 

3. Background and Statement of the Problem:  Begin your proposal with a back-

ground for the study and the statement of the problem. The problem must be clearly 

stated: Exactly what is to be researched?  You may also show the scope or extent of 

the problem. It should point to: 

A gap in knowledge 

An unclear situation 
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An unresolved question 

A lack of information 

An unknown 

A specific question to be investigated and answered 

A problem to be researched and solved.   

Any historical information that provides greater understanding or clarification of 

the topic is valuable.  

5. Thesis Statement: A concise statement that communicates the main premise of the 

thesis, often in a question form. 

6. Purpose: Determine what to do with the problem. Are you going to analyze? Com-

pare? Reconstruct? Synthesize? The purpose of the thesis tells the reader what you 

are going to do about the problem.  

7. Objectives and Significance:  

What is the value of the research to a given discipline?  Why is doing this 

research important? 

You may also present the significance of your research. Who will benefit 

from having this problem solved?  How important is it to answer this             

question?   

8. Delimitations and Limitations:   

The delimitations outline the parameters chosen by the writer—what will and 

will not be discussed. 

In defining limitations, the writer points out any hindrances to the study, 

such as shortness of time, lack of library facilities, or language limitations. 

9. Definition of Terms: It is important to indicate the specific use of certain terms. In 

doing so, readers are informed of their exact use, as they may not be familiar with 

denominational or local terms, or unique terms that characterize one’s own tradition. 

10. Methodology: Methodology refers to the way you will go about achieving the pur-

pose already stated.  You must ask, “How am I going to do this?”  The thesis super-

visor and faculty reader need to be convinced that the route you have chosen will 

lead to a successful resolution of the problem.   

11. Presuppositions or Assumptions: Presuppositions or assumptions are basic under-

standings that undergird the researcher’s thinking on a given topic—in other words, 

what we take for granted. Readers will be better able to follow the researcher’s 

thinking when they know the presuppositions/assumptions of the writer. 

12. Hypothesis (optional, depending on topic):  Tentative solution to the problem; an 

indication of the expected result of the study. 

 
 



 8 

 

Bibliography:  15 annotated bibliographic sources and at least 45 additional sources.  

An annotated bibliography contains the usual bibliographical information; but in addi-

tion, it gives a brief description of the summary and evaluation of a source (see 

Vyhmeister, p. 55 for examples). See example pages. 

 

Sample Outline: 

 

I.  First level sentence. 

A.  Second level sentence. 

B.  Second level sentence. 

1.  Third level sentence. 

2.  Third level sentence. (If the information in a given level is long enough to 

need more than one line, be sure to single space within the level, double 

space between levels, and begin succeeding lines immediately below the first 

letter of the first word of the first line.) 

a.  Fourth level sentence. 

b.  Fourth level sentence. 

(1)  Fifth level sentence. 

(2)  Fifth level sentence. 

(a)  Sixth level sentence. 

(b)  Sixth level sentence. 

II.  First level sentence. 

A.  Second level sentence. 

B.  Second level sentence. 

1.  Third level sentence. 

2.  Third level sentence. 

a. Fourth level sentence. 

b. Fourth Level sentence 

(1)  Fifth level sentence. 

(2)  Fifth level sentence. 
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GBIB/GTHE 757 THESIS WRITING:  

WRITING THE TEXT OF THE THESIS 
 

The thesis is expected to reflect logical and analytical thinking, appropriate organiza-

tion, the use of standard English and acceptable grammar and punctuation, proper docu-

mentation, and neat appearance.  Writing should be concise, yet comprehensive, and the 

qualities of unity, coherence, and clarity are paramount.  
 

Criteria:  While writing your thesis, keep in mind the following criteria (from the thesis 

rubrics) for each academic degree program. 
 

M. A. Biblical Literature 
Deploy critical interpretative methods and tools through use of sources and reflec-

tion upon biblical themes 

Show knowledge of and ability to discuss diverse perspectives, critical issues, and 

arguments impinging on the research thesis 

Display ability to translate and interpret major portions of biblical passage(s) in         

research and the development of a thesis 

Show coherence, logical consistency, and systematic correspondence in                         

development of thesis 

Show ability to appreciate, integrate, and apply today’s biblical truths and/or ethical 

demands educed from research 
 

M. A. Biblical Literature/Advanced Languages Concentration  

Deploy critical interpretative methods and tools and show appreciation for advanced 

languages through use of sources and reflection upon biblical themes 

Show knowledge of and ability to discuss diverse perspectives, critical issues, and 

arguments impinging on the research thesis  

Display ability to translate and interpret major portions of biblical passage(s) and 

cognate texts in research and in the development of a thesis 

Show coherence, logical consistency,  systematic correspondence in the                           

development of a thesis 

Display ability to appreciate, integrate and apply today’s truths or ethical demands 

educed from research 
 

M.A. Biblical Literature/Judaic-Christian Studies Concentration 
Deploy critical interpretative methods and tools and show appreciation for Judeo-

Christian literature through use of sources and reflection upon biblical themes 

Show knowledge of and ability to discuss diverse perspectives, critical issues, and 

arguments impinging on the research thesis 

Display ability to translate and interpret major portions of biblical passage/s and 

Jewish literature in research and in the development of a thesis 

Show coherence, logical consistency,  and systematic correspondence in develop-

ment of thesis 

Show ability to appreciate, integrate and apply today’s biblical  truths and/or ethical 

demands educed from research 
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M. A. Theological/Historical Studies 
Show an exemplary proficiency in historical methodology for exploring historical/

theological themes 

Display an extensive knowledge of diverse interpretations, critical issues, and                                      

arguments impacting the research thesis 

Display an extensive knowledge of cultural and social backgrounds correlative to 

thesis topic 

Show coherence and logical development of thesis 

Show an exemplary ability to integrate, and apply historical and theological truths 

Demonstrate a masterly knowledge and use of recognized source materials 

Shows an exceptional use of style and form showing full knowledge of scholarly                

referential data 

 

 

PARTS OF A THESIS:  (Also see example pages section of this manual) 

A. Front Pages (or Front Matter)   

The front pages of the document are counted but are not numbered. Begin inserting 

numbers in the Preface (if used) or Acknowledgments, using lower-case roman numer-

als, centered .75” from bottom of page.  Front pages include the following in the order 

given: 

1. Blank sheet (fly page) for protection during binding 

2. Title page (begin counting front matter) 

3. Disclaimer page  

4. Approval sheet 

5. Abstract  

6. Copyright  

7. Dedication (if used)  

8. Preface (if used) (begin inserting numbers) 

9. Acknowledgments (if no Preface, begin inserting numbers) 

10.   Table of Contents (example and formatting pages) 

11. List of tables (if used) 

12. List of figures (if used, see Turabian for formatting) 

B. Main Body of Text (75-100 pages, Times New Roman 12-pt. font, 3-4 chapters) 

C. Back Pages (or Back Matter)    

The back pages of the thesis should include the following in the order given: 

Appendix(es) (if used) 

Bibliography (60-75 sources, 1/3 periodicals) 

Vita (no page number); add blank sheet (fly page) when printing. 
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OVERVIEW: SEMINAR IN THEOLOGICAL RESEARCH  
 

GTHE 517 Seminar in Theological Research is designed to enable the theologi-

cal research student to acquire a degree of expertise in the use of the library’s many fa-

cilities.  The course emphasizes a working knowledge of research tools and research 

methodology, discusses selective problems in theological research, and addresses the 

scholarly process and modern information systems.  Particular emphasis is placed on 

theological bibliography, critical methods of reading and studying, and writing.  The 

course also examines the basic form, content, and style of an acceptable theological re-

search paper.  While the Research and Writing Manual was created as a resource for 

GTHE 517, it will also prove valuable as a reference when doing assignments for other 

seminary courses.  
 

Required Textbooks  

Fee, Gordon D., and Douglas Stuart. How to Read the Bible for All Its Worth. 
 3rd ed. Grand Rapids: Zondervan, 2003. 

 

GTHE 517 Research & Writing Manual: Graduate School of Theology and Ministry  

 Oral Roberts University—current year edition.  
 

Turabian, Kate L. A Manual for Writers of Research Papers, Theses, and Dissertations. 

 7th ed. Revised by Wayne C. Booth, Gregory G. Colomb, and Joseph M.  

 Williams. Chicago: University of Chicago Press, 2007. 
 

Vyhmeister, Nancy Jean. Quality Research Papers. 2nd ed. Grand Rapids: 
 Zondervan, 2008.  

 

Recommended:  
Strunk, William, Jr., and E. B. White. The Elements of Style. 4th ed. Boston: Allyn  

 and Bacon, 2000.  
 

Seminar in Theological Research has two major components: gaining research 

skills and improving writing skills. To complete this course successfully, the student will 

need access to a city, county, university, or seminary library. Other sources for research 

could be a church library, pastor's professional library, online books, e-books, and Bible 

software programs (i.e. Logos).  For this course, focus your research primarily on works 

by academically strong authors/sources (those with sound biblical/theological educa-

tions and/or are recognized experts in the areas on which they write/teach), not leaning 

too heavily on works by pastors, evangelists, and other ministers. Although many pas-

tors, evangelists, and other ministers may have good things to say, especially in the area 

of personal application, often they do not deal specifically with the theological implica-

tions required by this and other courses. Exceptions to this can be found; however, 

please stay primarily with academically strong sources.  On average, the student should 

plan a time commitment of six to eight hours per week to complete the course. 

Form and Style 

If  any man wish to write in a clear style,  

let him first be clear in his thoughts;  

and if  any would write in a noble style,  

let him first possess a noble soul. 
 

—Johann Wolfgang von Goethe 
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FORM AND STYLE REQUIREMENTS 

 
Abbreviations, Apocrypha  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Additions to Esther Add Esth 

Baruch Bar 

Bel and the Dragon Bel 

Epistle of Jeremiah Ep Jer 

1 Esdras 1 Esdr 

2 Esdras 2 Esdr 

Judith Jud 

1 Maccabees 1 Macc 

2 Maccabees 2 Macc 

Prayer of Manasseh Pr Man 

Ecclesiasticus  

(Wisdom of Jesus the Son of Sirach) 

Sir 

Song of the Three Children S Th Ch 

Susanna Sus 

Tobit Tob 

Wisdom of Solomon Wisd Sol 

Good News Bible GNB 

Living Bible LB 

King James Version KJV 

A New Translation of the Bible Moffatt 

New Century Bible NCB 

New English Bible NEB 

New International Version NIV 

New Jerusalem Bible NJB 

New King James Version NKJV 

New Living Translation NLT 

New Revised Standard Version NRSV 

New American Standard Bible 

New American Standard Bible, Updated 

NASB 

NASU 

Revised Standard Version RSV 

Today’s New International Version TNIV 

Abbreviations, English Bible 
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Abbreviations, Bible Books 

In modern academic usage, the abbreviations of the books of the Bible are not  

followed by periods. 

Abbreviate book names in footnotes or within parentheses; however, spell out book 

names in the text. 

Spell out the numbers for numbered books of the Bible when a sentence begins with 

a book name (e.g., Second Timothy).  Use Arabic numerals (1, 2) for numbered books 

when the book name is in running text (e.g., 2 Timothy). 
 

Old Testament Abbreviations 

Information adapted from Quality Research Papers by Nancy Vyheimster, p. 86, and SBL  

          Handbook of Style (Peabody, MA: Hendrickson, 1999). 

Genesis Gen   2 Chronicles 2 Chr   Daniel Dan 

Exodus Exod   Ezra Ezra   Hosea Hos 

Leviticus Lev   Nehemiah Neh   Joel Joel 

Numbers Num   Esther Esth   Amos Amos 

Deuteronomy Deut   Job Job   Obadiah Obad 

Joshua Josh   Psalms Ps   Jonah Jonah 

Judges Judg   Proverbs Prov   Micah Mic 

Ruth Ruth   Ecclesiastes Eccl   Naham Nah 

1 Samuel 1 Sam   Song of Solomon Song   Habakkuk Hab 

2 Samuel 2 Sam   Isaiah Isa   Zephaniah Zeph 

1 Kings 1 Kgs   Jeremiah Jer   Haggai Hag 

2 Kings 2 Kgs   Lamentations Lam   Zechariah Zech 

1 Chronicles 1 Chr   Ezekiel Ezek   Malachi Mal 

  

New Testament Abbreviations 

Matthew Matt   Ephesians Eph   Hebrews Heb 

Mark Mark   Philippians Phil   James Jas 

Luke Luke   Colossians Col   1 Peter 1 Pet 

John John   1 Thessalonians 1 Thess   2 Peter 2 Pet 

Acts Acts   2 Thessalonians 2 Thess   1 John 1 John 

Romans Rom   1 Timothy 1 Tim   2 John 2 John 

1 Corinthians 1 Cor   2 Timothy 2 Tim   3 John 3 John 

2 Corinthians 2 Cor   Titus Titus   Jude Jude 

Galatians Gal   Philemon Phlm   Revelation Rev 
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Abbreviations, Misc. 

You can find the abbreviations for the following writings in the abbreviation section of any vol-

ume of the Word Biblical Commentary (Dallas: Word 1988) or in the SBL Handbook of Style 

(Peabody, MA: Hendrickson, 1999): 

Commonly used periodicals, reference works, and serials 

Dead Sea Scrolls, Philo, and Josephus 

Early Jewish Literature (OT Pseudepigrapha); Rabbinic writings 

Early Christian Writings 

 

Abbreviations, Scholarly 
Confine general abbreviations etc., e.g., and i.e. to parenthetical references in text. 

The abbreviations cf., and s.v., are preferably used only in footnotes. 

Latin abbreviations are not acceptable in the document citations. 

The most common scholarly abbreviations (for full list see Turabian 24.7): 

 

App. appendix 

ca. circa, about, approximately 

cf. confer, compare (Confer is Latin for “compare;” cf. must not be used  as  abbreviation for 

ed. editor; edition; edited by 

e.g. exempli gratia, for example 

et al. et alia, and others 

et seg.  et sequentes, and the following 

etc. et cetera, and so forth 

f., ff. following (verse or verses, pages, etc.) 

hap. leg. hapax legomenon, sole occurrence 

id. idem, the same (used to refer to persons;  not to be confused with ibid.) 

i.e. id est, that is 

infra below 

n. note, footnote (plural, nn.) 

n.d. no date 

n.p. no place; no publisher; no pagination 

p. page (plural, pp.) 

passim  here and there; elsewhere 

q.v.  quod vide, which see (for use with cross-references) 

sic so, thus (always italicized or underlined); an unusual                                                         

supra above 

s.v. sub verbo, sub voce, under the word (plural, s.vv.; used in references to encyclopedias and 

v. verse (plural, vv.) 

viz. videlicet, namely 

vs. versus, against 
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Abbreviations, States 

In footnotes and bibliography use two-letter abbreviated form of the name of the state.  

Include state when the city may not be well-known to the reader.  See Turabian 24.3.1 

 

Abstract (M.A. Thesis)  

An abstract is a concise summary (approx. 150 words, normally on one page) in-

tended to inform prospective readers about the content of a thesis. 

It usually includes a brief description of the research, the procedures or methods, and 

the results or conclusions. 

An abstract should not include internal headings, parenthetical citations of items 

listed in the reference section, diagrams, or other illustrations. 

 

Bible Versions (also see Scripture Citations) 

In a biblical or theological paper, Bible references are commonly placed in      

parenthesis directly in the text.  In English, it has been accepted practice that no version 

is indicated when one uses the King James Version (KJV).  Any other version must be 

indicated in a footnote at the first Scripture reference in the paper: 
 

 1Unless otherwise indicated all Bible references in this paper are to the New 

American Standard Bible (NASB) (La Habra, CA: The Lockman Foundation, 1973). 

 

Although several versions may be used in the paper, this practice is discouraged.  

Unless word or sentence comparisons are being done between versions, use the same 

version throughout the paper.  Jumping from one version to another and choosing the 

wording that suits a specific purpose suggests that the author of the paper is trying to 

make the Bible say what he or she wants it to say (“proof texting”). 

If a quotation from an additional version appears in the paper, indicate this with the 

abbreviation for that version following the citation: e.g., (Rom 1:17, NIV). 

 

Bibliography/Bibliographic Sources and Documentation   (see example pages) 

Source citations (footnotes) are required in the text when using a direct quotation, 

paraphrasing another author’s words, or including specific information that is not com-

mon knowledge. 

References in the text must correspond exactly to the listing of sources at the end of 

the paper.  The bibliography should list only works that are referred to or quoted in the 

text. 

Be certain that all items are included in the bibliography that appear in the footnotes, 

author’s names are spelled consistently and correctly, and the dates are the same in both 

the footnotes and the bibliography. 

 



 16 

 Bibliography  continued 
Categorize your sources according to type:  Books, Periodicals, Online Sources, etc.  

Use the same format as you would for 1st level headings and alphabetize within each 
category.  Do not list a source in more than one section unless it could clearly be catego-
rized in two or more ways.  See example Bibliography near end of manual. 

GTHE 517: For research paper, approximately 8-12 sources needed, as instructed by 

professor (1 source per page length of paper). 

GBIB/GTHE 757: For M.A. Thesis, between 60-75 sources should be used; at least 

one-third should be periodicals. 

Margins:  Top (first page) 2”; (following pages) 1.4”; Left, bottom, and right 

1”  (NOTE: for M.A. Thesis, left margins are 1.5” to allow for binding.)    

Pagination (Page numbering) 

Continue numbering from the last page of the main text. 

Page number on first page is centered 0.75” from bottom. 

Following page numbers are 1 inch from top and right edge of page. 

To transfer footnote information to the bibliography: 

Go to View, switch to Draft. 

Click Insert, Show Notes. 

Select all (Ctrl+A) then Copy (Ctrl+C) 

Open Bibliography (should be separate document) and Paste (Ctrl+V) 

Arrange and format accordingly. 
 

Chapter Headings and Chapters (M.A. Thesis) 

Begin each chapter on a new page;  

Use capital letters and Arabic numerals (CHAPTER 1) 2” from top of page. 

Title of chapter is in all capital letters, doubled spaced from chapter designation. 

3 blank lines between chapter title and text; text begins on 4th line.  

An M.A. thesis is normally divided into 3-5 chapters. 

Introductory and concluding sections are included in the first and last chapters. 

Subheadings will indicate the orderly progression of topics and their relationships. 
 

Commas 

The subject of comma usage is much too comprehensive to include here.  Read and 

refer to Turabian 21.2 for specific directions. 

In a series, always use a comma before the conjunction that introduces the last item: 

              He studied Greek, Latin, and Hebrew.   (Turabian 21.2.2) 

Use paired commas to set off a nonrestrictive clause (a clause that is not necessary to 

identify the noun it modifies): 

             These five books, which are on reserve in the library, are required reading.   

             (Which books?  These five books.) 

Restrictive clauses:  Commas are not used around restrictive clauses (a clause that is 

necessary to identify the specific noun it modifies): 

 The books that are required reading are on reserve in the library.   

 (Which books?  The books that are required reading.) 
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Conclusions 

A conclusion is essential to complete an argument, and draws the presentation to a 

close.  

It contains a restatement of the thesis, and reminds the reader of the main points.  

In the conclusion, do not simply list the points of your argument. Rather, rephrase  

your points using sharp, clear, and concise words.  

Do not use a quotation/paraphrase from someone else as a concluding statement. 

 

Copyright©  (M.A. Thesis) 

Copyright privileges vest immediately upon creation of the work, without the re-

quirement of notice or registration formalities.  One should, nevertheless, include a 

copyright notice with the work. It signals an acknowledgment of legal rights to the read-

ers, copyright ownership, and indicates the first year of publication. 

Registration is technically optional, but still recommended.  It establishes a public 

record of the document, the copyright, and the author’s name and address. For American 

publications, registration is required before one can file an infringement lawsuit.   

Timely registration bestows additional legal rights, particularly the ability to receive 

"statutory damages" and attorney fees in an infringement action.  Those remedies may 

be the sole monetary award from an infringer.  In general, to have these benefits, authors 

must register before the infringement occurs. 

For  more information, see ProQuest UMI: www.umi.com/hp/Support /DServices/

copyright/Part5.html. U.S. Copyright: www.copyright.gov, or call (202) 707-3000. 

 

Ellipses  (See Turabian 25.3.2) 

An ellipsis is a series of periods, separated by spaces, used to mark an omission of 

words, phrases, or paragraphs in quoted material. 

To omit material between sentences but quote the sentence preceding the omission 

in full, put the terminal punctuation mark immediately after that sentence; then leave a 

space between the ending punctuation mark and the ellipsis dots: 

“When a nation is wrong, it should say so and apologize. . . . It should also take 

steps to change the situation.” 

If the omission does not include the end of the preceding sentence, put a space  

instead of a punctuation mark immediately following that sentence.  After the space, use 

three spaced ellipsis dots to represent the omission: 

     “When a nation is wrong, it should say so . . . It should also change the situation.” 
 

Emphasis Added   (See Turabian 25.3.1) 

To italicize for emphasis words that are not italicized in an original quote or your 

text, you must indicate the change with emphasis added. 

Within the text, add notation in square brackets [   ] immediately after italicized 

words:  According to Schulz, “By the end of 2010, every democracy [emphasis added] 

will face the challenge of nuclear terrorism.” To add italics at two or more points in a 

quotation or text, use the [emphasis added] after the last point.  

Only use “emphasis added” for quoted materials. 

http://www.umi.com/hp/Support%20/DServices/copyright/Part5.html
http://www.umi.com/hp/Support%20/DServices/copyright/Part5.html
http://www.copyright.gov
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Eras 

Use BC and AD, or BCE and CE. 

Use capital letters without periods. 

AD precedes the year; the other designations follows it:   

      The temple was destroyed in 586 BC and again in AD 70. 

 

First Pages (Main Text, Bibliography)    

The format of the first page is different than subsequent pages in a paper. 

Top margin: 2”; (1.4” on subsequent pages). 

Page number: centered 0.75” from bottom; (1” from top and right margins on subse-

quent pages). 

Also see Line Spacing section. 

Fonts 

The accepted font type for the paper is Times New Roman.   

The font size is a standard 12 for both text and footnotes.  

Bold print is not acceptable for any portion of the document.   

Use italics or underline only when Turabian gives the option.  

 

Fonts, Greek and Hebrew (and other biblical era languages)    

If Greek or Hebrew (or other) text is used, avoid bold type of font. If the font looks 

bold (even if not selected as bold), it must be approved before use.   

The citations of Greek or Hebrew (or other language) texts are put in block  

quotations.   

Hebrew text is right justified. 

To download font from your computer: 

Go to Control Panel (Click Start on lower left corner of screen) 

Open font folder.   

Select and copy (Ctrl + C) the Greek and/or Hebrew font used and paste it 

(Ctrl + V) to the flash drive. 

To space Hebrew text properly in your paper, conform to the following guidelines: 

Select Text, then click on Format, Paragraph.  

Under Line Spacing select Exactly and type 24 into the pt box.  

Block Quotes should be spaced at exactly 12 pts.  

Double Space = 24 pts; Single Space  = 12 pts. 

Free Hebrew and Greek fonts are available at www.teknia.com/free_fonts. 

Do not italicize foreign words in non-English alphabets (e.g. Greek, Hebrew). 

 

Footnotes    

Text and footnotes are separated with a two-inch unbroken line (made automatically 

by word processor), beginning at the left margin. 

Footnotes are to be typed immediately below the separation line. 

 

http://www.teknia.com/free_fonts


 19 

Footnotes  continued 

Footnote separators that extend across the page are not acceptable. 

The first line of each footnote should have same indentation as the paragraph       

indentations in your text (one-half inch). 

No space should appear between the footnote number and the footnote itself. 

Footnotes must be in 12-point font. 

Footnotes must be single-spaced when more than one line in length; the second and 

following lines are left justified. 

Double-space between footnotes. 

Number footnotes sequentially throughout the paper. 

M.A. Thesis only: Footnote numbers must begin at 1 again at the beginning of each 

chapter. 

Do not repeat the full citation of a source if it was used previously. 

For example, when referring to a source that has already been cited in full, give only 

the last name of the author and the page number. 

Include title if there are more works by the same author. 

Latin abbreviations are not acceptable (e.g., Ibid., op cit.). 

Endnotes and parenthetical references (as used in MLA or APA style) are not ac-

ceptable. 

To transfer footnote information to the bibliography: 

Go to View, switch to Draft. 

In MS Word 2007, go to Reference tab; in Footnotes group, Show Notes.   

      (In Word 2003, click Insert, Show Notes.) 

Select all (Ctrl+A) then Copy (Ctrl+C) 

Open Bibliography (should be separate document)                                                             

and Paste (Ctrl+V) 

Arrange and format accordingly. 
 

Foreign Language Terms/Transliterations 

Italicize transliterations and isolated words and phrases in foreign languages likely 

to be unfamiliar to readers of English. 

     “The terms parabolē in Greek and mashal in Hebrew require some qualification.”   

If you define a foreign term, put the definition in parenthesis or quotation marks  

following the term in the text. 

            In biblical criticism, Sitz im Leben is a German phrase roughly translating to   

            "setting in life.” 
 

Greek Citations    
Block quotes need to begin one-half inch from left margin, double-spaced after text. 

The English translation of the text also begins one-half inch from left margin, double

-spaced after citation of Greek text. 

At the end of the translation, double space been the translation and the start of the 

remainder of the main body of text. 

Both the Greek text block quote and the English translation are single-spaced. 
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Headings and Subheadings  (M.A. Thesis) 

Think of the headings as the outline of the paper; you must have at least two             

headings in a level. (You can’t have an A without a B in an outline) 

Subheadings must use exactly the same wording as the Table of Contents 

If the subheading text itself extends two lines, single-space the subheading. 

All headings use the same font as the text of the paper 

Do not type a heading near the bottom of a page unless there is a room for at least 

       two lines of text following the heading (see Widows and Orphans Section).  Instead,  

       simply leave a little extra space on that page and begin the heading on next page. 

Neither bold nor italics is acceptable for headings. 

Also see section on Line Spacings. 

Subheadings can consist of up to five levels, although not all five need to be used  

      unless they are applicable to the organization of the text.   

 

Level 1 - Centered and Underlined 

 

Level 2 – Centered and Not Underlined 

 

Level 3 – Justified Left and Underlined 

 

Level 4 – Justified Left and Not Underlined 

 

Level 5 begins a paragraph.  It is underlined and has a period at the end.  The 

text then continues as normal. 

 

Hebrew Citations  
For block quotes, use same format as for Greek (above), only use right justification 

for Hebrew text. 

To space lines with Hebrew text properly: 

Select text 

Click on Paragraph tool bar 

Under Line Spacing, select Exactly and type 24 into the pt. box 

(Double space = 24 pts.)    (Single space = 12 pts.) 

Block quotes should be spaced at exactly 12 pts. 

Do not italicize foreign words/phrases in non-English alphabets. 

 

Hyphens and Dashes  
A hyphen is a single line between two words made with one stroke of the hyphen 

key  (e.g., Tulsa is a fast-growing city).   

Avoid using hyphenation in your document, unless there is excessive space at the  

end of the line.   
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Hyphens and Dashes  continued 

An em-dash (width of an “M”) is made with two conjoined hyphens to set off text in 

a way similar to but more prominent than commas (e.g., Research reading—beyond the 

early exploratory reading—takes time.).   

An en-dash (width of an “N”) usually means “through” and is used to connect  

numbers and, less often, words:  The years 1993-2000 were heady ones. 

Do not leave spaces before or after hyphens or dashes.  

See Turabian 21.7 for more information 

 

Inclusive Language 

When possible, avoid gender-specific language when referring to human parties (use 

“people” or “humanity” rather than “men”).  With regard to God, use masculine pro-

nouns.   See CMS 5.222-5.227. 

 

Indention    
The first line of the paragraph begins one-half inch from the left margin.  The whole of a 

block quotation is indented (not tabbed) one-half inch from the left margin. 

 

Italics 

Book Titles 

Italicize book titles in bibliographic and footnote entries/citations. 

Italicize book titles in running text. 

The Mishnah and The Jewish Encyclopedia were crucial in the research findings. 

Emphasis Added (Turabian 25.3.1) 

If you italicize for emphasis words that are not italicized in an original         

quotation , you must indicate the change with emphasis added. 

Within the text, add notation in square brackets [   ] immediately after itali-

cized words: 

According to Schulz, “By the end of 2010, every democracy [emphasis added] 

will face the challenge of nuclear terrorism.” 

If you add italics at two or more points in a quotation or text, use the 

[emphasis added] after the last point. 

Foreign Language Terms/Transliteration 

Italicize transliterations and isolated words and phrases in foreign languages 

likely to be unfamiliar to readers of English. 

     “The terms parabolē in Greek and mashal in Hebrew require some qualification.”   

If you define a foreign term, put the definition in parenthesis or quotation 

marks  following the term in the text. 

In biblical criticism, Sitz im Leben is a German phrase roughly translating to 

"setting in life.” 

Do not italicize words/phrases in non-English alphabets. 
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Justification 

  Left justification is the standard for a paper.  Right justification is not acceptable in 

any area of the document.  The only exception is with Hebrew block quotations, which 

are right justified. 

 

Length of M.A. Thesis 

75-100 pages, Times New Roman 12 pt. font 

Do not use an appendix to exceed the maximum length of the body of the thesis. 

 

Line Spacing 

Text is to be double-spaced. 

Single spacing is allowed in certain limited cases: block quotations, headings, table 

titles, figure captions, tables, and appendices.  It is also permitted within items in the 

list of tables, list of figures, bibliography, and footnotes.   

Line spacing of multiple (1.15 and other increments) is not acceptable. 

Between end of text and next subheading:  3 single spaces (2 blank lines between; 

text starts on 3rd line) 

Between subheading and text: 2 single spaces or 1 double space (1 blank line be-

tween; text starts on 2nd line) 

For Bibliography first page: between “BIBLIOGRAPHY” and “Books” section: 4 

single spaces or 2 double spaces (3 blank lines between; text starts on 4th line) 

Between “Books” section and first bibliographic entry: 2 single spaces or 1 double 

space (1 blank line between; text starts on 2nd line) 

See examples below.  The paragraph mark ( ¶ ) is included to show line spaces. 

 

LINE SPACING EXAMPLES: 

 

     Clearly one of the most distinctive points of time in the history of the church is the  

¶ 

Pentecostal outpouring that came like a flood in the early part of the twentieth century.  

¶ 

According to most sources, William J. Seymour was the dominant figure in this historic  

 

event . ¶ 

¶ 

¶ 

¶Azusa Street 

¶ 

     The Azusa Street Revival significantly shaped and impacted the Pentecostal  

 

churches of America in the early part of the twentieth century. . . . 

 

 

There are 2 blank single-spaced lines 

between text and next heading. 
 

Heading is on the 3rd line. 
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Line Spacing  continued 
 

BIBLIOGRAPHY (ALL CAPS) 

¶ 

¶ 

¶ 

Books  
 

DiSante, Carmen.  Jewish Prayer: The Origins of Jewish Liturgy.  New York: Paulist  

 Press, 1985. 

 

Donin, Hayim Halevy.  To Pray as a Jew.  New York:  Basic Books, 1980. 

 

Margins    
The margins should be set as follows: 

Research papers: left 1” 

M.A. Thesis: left 1.5” (to allow for binding) 

Bottom and right 1”     

Top 2” (for title page, first page of text, and bibliography)  

Top 1.4” (for following pages)  

 

Names with Junior, Senior, and III  

Commas are no longer required around Jr. and Sr, nor are they used to set off II, III and 

such as part of a name:   

George Wilson Sr. has finally finished his thesis. 

John Downey III is the son of John Downey Jr. 
  
Numbers 

Spell out numbers under 101, except for Scripture references, dates, or years of ages. 

There were seventeen manuscripts in the library. 

He had studied 257 sources to write his book. 

If a number has two words, use a hyphen (fifty-five). 

Spell out round numbers followed by hundred, thousand, etc. 

   The population of the area was twelve million. 

Always spell out a number that begins a sentence. 

Four men went in search of a lost civilization. 

 

Pagination (Page Numbers)   

Every page in the document, including Bibliography, must be counted.   

Body of Paper: 

Pagination should be started from the first page of the main text and          

continued throughout. 

Use Arabic numbers (1, 2, 3) of same size and font type as the main text. 

 

<  (line 1) There are 3 blank single-spaced  lines  

<  (line 2) 

< (line 3) 

<  Sub-heading is on the 4th line 
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Pagination  continued 

The page number on the first page is centered 0.75” from bottom of page. 

Following page numbers are 1 inch from the top and right edge of page. 

Bibliography 

Continue numbering from the last page of the main text 

Page number on first page is centered 0.75” from bottom. 

Following page numbers are 1 inch from top and right edge of page. 

 

Paragraphs    

The first line of each paragraph should be indented one-half inch. 

A paragraph must have at least three sentences. 

Avoid “widows and orphans”—carrying over just one line of a paragraph to the fol-

lowing page or starting a paragraph with one line at the end of the page. Set the 

“widow and orphan control” to automatically prevent the above from happening. 

 

Print Quality 

Only sharp laser quality print with uniform blackness is accepted.   

Print single-sided only.   

If a laser printer is not available, transfer the document onto a flash drive or disc for 

printing at another location, such as Kinko’s or the ORU Document Preparation  

Services.   

Warning: When using another computer and/or printer, often formatting is auto-

matically changed; for example, the last line on a page may shift to the next page, or 

tabulations may change.    

Saving your document as a PDF file will minimize formatting changes during print-

ing; however, some adjustments may still be needed. 

See Embedding Fonts section. 

 

Quotation Marks 

The period ending the quotation should be placed before the quotation mark (.”). 

If quoted material ends in a semicolon or colon in the original, the punctuation can 

be changed to a comma or period to fit with the structure of your sentence. 

Use ”? or ”! if the punctuation refers to entire sentence of which quotation is part. 

Use ?” or !” if the punctuation is a part of the quoted material. 

Use a single quotation mark (‘) for a quote within a quote. 
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Quotations 

All quotations are to be introduced: 

While most scholars accept this theory, Dr. John Jones denies its viability: 

“There is no evidence whatsoever to support this.”  

Use the full name of an author when he/she is mentioned for the first-time. Subse-

quent references to an author can refer to last name only. 

When referring to the stated views of present or past writers, use the historical pre-

sent tense (see Vyhmeister, p. 119). 

Suggested verbs that can be used to introduce quotations: 
 

 
Quotations, Block    

Block quotations must be five or more lines of text in length; Greek and Hebrew cita-

tions are the exception. 

Must be single spaced, and indented one-half inch from left margin only. 

No quotation marks at the beginning or end. 

If the block quotation itself is a complete paragraph in the original source, the first 

line of the block quotation is tabbed an additional one-half inch. 

Quotations should be typed exactly as in the original, including wording, spelling, 

capitalization, and punctuation. If a word is misspelled in the quote, place [sic] immedi-

ately after the misspelled word. This designates that the incorrect spelling appears in the 

original. 

Note: Hebrew and Greek passages are always put in block quotes, whatever the 

length.  For further information, see Turabian 25.2.2. 

 

Scripture Citations (also see Bible Versions and Bible Abbreviations above) 

“Bible” should always be capitalized. 

The following Bible versions are suggested for the paper: KJV, NASB, NIV, NKJV, 

NLT, NRSV, RSV, or TNIV (see Abbreviations, English Bible). 

Footnote the first Scripture citation with a statement indicating which translation 

will be used for quotations, along with the publisher’s information. Example: 
2Unless otherwise indicated all Bible references in this paper are to the New 

American Standard Bible (NASB) (La Habra, CA: The Lockman Foundation, 1973).  

All subsequent scriptural citations should appear in the body of the paper and not in 

footnotes. 

accepts 

adds 

admits 

affirms 

agrees 

argues 

asks 

believes 

combats 

confirms 

declares 

defends 

denies 

describes 

discusses 

expresses 

indicates 

labels 

mentions 

objects 

opposes 

points out 

points to 

portrays 

proposes 

recalls 

recommends 

reports 

reveals 

states 

stipulates 

submits 

suggests 

thinks 

verifies 

writes 
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Scripture Citations   continued 

If a quotation from an additional version appears in the paper, indicate this with the 

abbreviation for that version following the citation: e.g., (Rom 1:17, NIV). 

Do not use excessive wording when referring to Scripture.  For example, do not 

write, “chapter fourteen verses 3 through 6.” Simply write “14:3-6.” 

Multiple citations within the same chapter are separated by commas (e.g., Rev 3:6, 

11, 13), but semicolons separate citations from different chapters and books (e.g., 2 

Thess 2:1; 3:4; Rev 3:16). 

When chapters or verses are cited in parentheses, use ch./chs. and v./vv. (e.g., ch. 3; 

chs.1, 3; v. 1; vv. 4-9). 

Abbreviate Bible book names in footnotes or within parentheses  (See Abbreviations            

Bible Books); however, spell out book names in the text.   

Spell out the numbers for numbered books of the Bible when a sentence begins with 

a book name (e.g., Second Timothy).   

Use Arabic numerals for the numbers of numbered books of the Bible when the 

book name is in running text (e.g., 2 Timothy). 

 

Spacing After Punctuation 

There is to be one space after all punctuation marks ending each sentence. 

Do not leave a space after colons when used in Scripture references (1 Cor 1:2), be-

tween hours and minutes (5:20 p.m.), or between volume and page numbers            

(2:123-142). 

Do not leave a space after periods in abbreviations such as i.e., e.g., Ph.D., A.M., 

P.M. 

Single space after periods of the initials of personal names, (R. C. A. Lentki). 

 

Table of Contents (M.A. Thesis) 

The TOC is essentially a topical outline of the work, compiled by listing the               

headings in the thesis, using the exact same wording 

The title, disclaimer, approval, abstract, copyright, and vita pages are not included 

See Setup Instructions in the Formatting the Paper section 

 

Tables/Graphs (M.A. Thesis) 

All figures must have narration in the text to introduce or conclude.  The narration 

(explanation) for a figure comes after the figure itself. 

See Turabian 26.1.1; 26.2.2; 26.3.2, and chapter 8 for more detailed information. 
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Tabs 

Default tab should be set at 0.5 inch.  

 

Title page 

Top margin, 2”. 

Type title of the work using all capital letters; double space between lines if needed. 

Be sure the title is in the shape of an inverted pyramid (if more than one line) 

Use transliteration for Greek or Hebrew words if used in the title. 

Line 1: Title in (or first line of title) 

Line 12: “A Research Paper . . .”  

Line 28 “In Partial Fulfillment . . .” 

Line 36: “By” 

See example of title page in Example Pages section  

To help in setting up title page: 

Set margins 

Go to Page Layout and click Line Number 

Click Continuous 

As you go down the page, the line numbers will automatically show up on 

your left so that you know what line you are typing on. 

When you’ve finished, go back to Page Layout, click Line Number, and    

unselect Continuous; the line numbers will disappear. 
 

Vita  (M.A. Thesis) 

The Vita is a brief biographical sketch of the writer which should include the date  

      and place of birth, parents’ names, schools and colleges attended, degrees awarded,  

      and professional experience.  

It comes after the Bibliography and has no page number. 
 

Widows and Orphans 

An “orphan” is a heading or the first line of a paragraph that remains as the last line 

on a page. 

A “widow” is the last line of a paragraph alone at the top of the next page. 

Neither is acceptable and can be prevented.  

Make sure at least two lines of text in a paragraph remain together. 
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Formatting the Paper 

Art and science have their meeting point in method. 
 

—Edward Bulwer-Lytton 
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FORMATTING THE PAPER 

 

The following formatting instructions are based on the program Microsoft Word 2007 

for Windows.  This manual is prepared specifically for students writing biblical and 

theological theses according to the style requirements of the Graduate School of             

Theology and Ministry at Oral Roberts University. 

 

SAVING YOUR WORK 
 

Backing up 

Immediately after beginning the first chapter, save this new document on the hard drive 

of your computer. It is recommended that a folder be created in which all documents 

pertaining to the paper will be kept. It is also absolutely essential that backup copies be 

made of the document and kept in a safe place, in the event that your computer breaks 

down, all work will not be lost.  Therefore, at the end of each work session make a copy 

to a flash drive or CD. 

 

AutoRecover 

The AutoRecover feature lets Word automatically save your document periodically. If 

the computer unexpectedly shuts down, (i.e., due to a power blackout) the document 

will be recovered. It will be opened the next time Word is launched.  To set                

AutoRecover feature: 

1. Click on the Office button  and go to Word Options. 

2. Click on Save tab on the left-hand side of the screen. 

3. Click on the check box and enter the time period for AutoRecover. 

 
4. Click OK. 

You will be able to see the progress of AutoRecover saving in the Status Bar. If your 

document is large, Word may appear to have stopped functioning while the save takes 

place. 

 

 

PAGE SETUP  
 

It is helpful to save each part of the paper as a separate document: i.e., Title Page,  

      Main Body, Bibliography, etc. Creating a template for each of these is  

      recommended. 

Make sure to set the margins, header and footer, font, etc. for each individual   

      document. 
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Margins and Paper Size  

To set the margins on the page: 

1. Click on the Page Layout tab and open the Page Layout dialog box by clicking the 

appropriate arrow. 

2. Click on the Margins tab if it is not on the top.  

3. Select margins:  Top 1.4,” Bottom 1” and  Right 1.”  

      NOTE: Research papers: Left 1”; M.A. Thesis, Left 1.5” (to allow for binding) 

1. Select paper orientation: Portrait.  

2. Click on the Paper tab. 

6. Select Letter paper size. 

7. Click OK.  

Your margins, paper orientation, and paper size are set. 

 

Setting the Default Font 

Times New Roman 12-pt. is the required font type for all papers. You can set the default 

font type for all of your documents. To set the default font type: 

1. Click on the Home tab and open the Font dialog box. 

2. Click on the Font tab if it is not on the top. 

3.     In the Font box, select the font type you 

        would like to use in your paper. 

4. Font Style—select Regular. 

5. Size—select 12. 

6.     Click Default button and OK. The default font is set. 

 

Widows and Orphans 

An “orphan” is a heading or the first line of a paragraph that remains as the last line on a 

page. A “widow” is the last line of a paragraph alone at the top of the next page. Neither 

is acceptable and can be prevented by following these guidelines: 

1. Click on the Home tab and open the Paragraph dialog box. 

2. Click on the Line and Page Breaks tab. 

3. Put a check mark in front of Widow/Orphan control. 

4. Put a check mark in front of Keep with next. (This prevents the subheading from 

appearing at the bottom of the page with no text below.) 

5. Click OK.  
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Page Breaks 

To set the text to appear on the top of the next page (e.g., a new heading) do not press 

the enter key until the text falls onto a new page. When you print your paper, the text 

could drift back to the previous page. Instead of using hard returns, you should insert a 

manual page break function. 

To set a page break: 

1. Position the cursor after the last line of your text where you want the page break to 

appear. 

2. Click on the Insert tab. 

3. Click Page Break in the Pages section of the menu. 

4. A new page will open. 

 

Hyphenation 

Automatic hyphenation is not be used in a paper. This function should be turned off in 

your document. 

To turn off the automatic hyphenation: 

1. Click the Page Layout tab. 

2. In the Page Setup section of the menu, click the Hyphenation button. 

3. Click None. 

 

Line Spacing 

The text of the paper is to be double spaced.  Before beginning to type the text of the 

paper, set the double spacing in your document. 

To set proper spacing: 

1.   Click on the Home tab. 

2. In the Paragraph section of the menu, click the Line Spacing button. 

3. Click the number 2. 

4.   The text is now set for double spacing. 

 

 

PAGE NUMBERS 

Arabic numbers are used for the body of the text and bibliography 

(For M.A. Theses only: Use lower case roman numerals for the front matter.) 
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PAGE NUMBERS  continued 

In order to avoid problems with numbering in a Word document, it is recommended 

that you create a separate file for the body of the paper, as well as for the title page 

and bibliography. 

 

Numbering the Front Matter (M.A. Thesis) 

The first part of the front matter consists of pages without numbers (title page, dis-

claimer page(s), approval, abstract, copyright, dedication, and preface). 

The second part has lower-case roman numerals at the bottom of each page 

(dedication, preface, acknowledgments, table of contents). 

In order to number the front pages you can create a separate document for every 

page and insert proper page numbers or leave it blank. 

There is also a way to create page numbers in one document consisting of all front 

pages.  Arabic numbers should be used starting on the first page of the first chapter of 

the project. 

 

Inserting the Page Numbers in One Document (M.A. Thesis): 

1. Create a document consisting of all front pages. 

2. Place your insertion point at the top of the acknowledgment page (if this is your first 

numbered page). 

3. Go to the Page Layout tab. In the Page Setup section, click Breaks. 

4. Click Next Page. 

5. On the toolbar, click on the Insert tab, select Page  Number. 

6. In the Page Numbers selection list, select Bottom of Page.  

7. Select the center-aligned page numbering format (generally titled ‘Plain Number 

2’). 

8. Go back to the Insert Tab, select Page Number, Format Page Numbers. 

9. In the Page Number Format dialog box, select Roman numerals (i, ii, iii, …). 

10. Under Page Numbering click on Start at and type the page number that you want 

(most likely number vi). 

11. Click OK. 

12. Go to Page Layout and then open the Page Setup dialog box. 

13. Click on the Layout tab. 

14. Set the header to 1” and the footer to 0.75”. 

15. Under Preview, select apply to Whole Document. 

16. Click OK. Now you should have numbers centered 0.75” from the bottom of the 

page. 
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Numbering the Body of the Text  

It is recommended that you create a separate document for the body of the paper and 

bibliography. 

Don’t forget to set margins, header and footer, and font etc. for each individual 

document. 
 

To set page numbers for the second and following pages of the paper: 

1. Insert a Page Break (Insert>Page Break) after the last word of your first page. 

2. Place your cursor on the second page of your document. 

3. On the toolbar, go to the Insert tab, select Page Number.  

4. In the Page Numbers selection list, select Top of Page. 

5. Select the right-aligned page numbering format (generally titled Plain Number 3). 

6. Go back to the Insert Tab, select Page Number, Format Page Numbers. 

7. In the Page Number Format dialog box, select Arabic numbers (1, 2, 3). 

8. Select Start at and insert page 2. 

9. Click OK. 

10. Go to Page Layout and then open the Page Setup  dialog box. 

11. Click on the Margins tab. 

12. Change top margin to 1.4” 

13. Click on the Layout tab. 

14. Set Section Start to New Page. 

15. DO NOT select Different First Page. 

16. Set the header to 1” and the footer to 0.75”. 

17. Under Preview, select apply to This Point forward. 

18. Click OK. 

 

The number on the first page of the text and the bibliography must be centered at 

the bottom of the page. (NOTE: For M.A. theses, this applies to the first page of 

every chapter and the bibliography.) 

To set the page number at the bottom of a page: 

1. Place your cursor on the first page of your document. 

2. Go to Page Layout and open the Page Setup dialog box. 

3. Click on the Margins tab, change top margin to 2” 

4. Click on the Layout tab, make sure header is set at 1”, footer at 0.75”, Section 

Start is set to New Page, and Apply To is set to This Section 

5. Check/click the Different First Page box. 

6. Click OK. 
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7. Go to Insert > Footer > Edit Footer 

8. Manually place your page number (1) with alignment set to center. 

9. You can substitute the following directions for steps 7 and 8:  

With your cursor placed in the first page of your document, go to Insert > 

Page Number > Bottom of Page > then select the centered number format 

(generally listed as ‘Plain Number 2’).   

Repeat the process for each first page. 

 

 

TABLE OF CONTENTS (M.A. Thesis) 
 

Create a separate document for the Table of Contents. 

Format margins 1.5 inch from the left and 1 inch from the right and bottom, and 2” 

from the top (second page top margin should be 1.4”). 

 

Dot Leaders and Page Numbers  

In order to create a dot leader between the heading text and the page number, you must 

set a right aligned tab with a dot leader in your document before you begin entering text 

and page numbers.  If you attempt to do this manually with periods and spaces, you may 

end up modifying every line in your table of contents when you change your printer 

driver. 

 

To set a right aligned tab with dot leader: 

1. From the Home tab, open the Paragraph dialog box. 

2. Click on Tabs. 

3. In the Tab Stop Position box type 6. 

4. Under Alignment, select Right. 

5. Under Leader, select 1 None. 

6. Click Set. 

7. Again in the  Tab Stop Position  box type 5.6. 

8. Under Alignment, select Right. 

9. Under Leader, select 2 (…..). 

10. Click Set. 

11. Click OK. 

 

Your tabs for dot leader and page numbers are set.   
 

Next, after you type the text, position the cursor on the first line of your Table of        

Contents immediately after the word Acknowledgments, and click the tab button (on 

your keyboard) twice.  The leader and short blank space will appear. Type the page 

number. Repeat clicking the tab twice for every page number in your Table of Contents. 
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Table of Contents: Chapter Headings, Subheadings, & Hanging Indents Setup 

(M.A. Thesis only) 

Note: It is recommended that you set the dot leaders (previous section), type all the text 

of the Table of Contents first, and then start formatting it. 

 

To set chapter headings in the Table of Contents: 

Select chapter heading (or subheading, see below) 

1. Click on the Home tab and open the Paragraph dialog box. 

2.   Click on the Indents and Spacing if it is not on the top. 

3.   In the Indention section, click on the down triangle under Special. 

4.   Select Hanging from the roll-down list. 

5.   In the By box, select 0.3.” 

6.  In the Left box select 0.3.” 

7.  Click OK. Next, position the cursor after the period behind the number of your chap-

ter, and tab once (on the keyboard). The title of your chapter will align at 0.3” from 

the chapter number. Repeat the process with all chapter headings.  

 

Setting Hanging Indents for Subheadings in Table of Contents: 

A hanging indent is characterized by the first line of the paragraph touching the left  

margin, and subsequent lines are indented.  You will need to create hanging indents for 

the headings in the Table of Contents. 

Follow the above procedures, but in step 6 in the Left box select 0.9” (for first level 

subheading).  

Click OK. 

Your hanging indent for the first level subheading is set. 

You will have to repeat the process for every level of subheading that you have in each 

of your chapters of your Table of Contents. Insert the following numbers: 

 

Level 2 subheading: in the indention section select: Left 1.2” and Hanging By 0.3.” 

Level 3 subheading: in the indention section select: Left 1.5” and Hanging By 0.3.” 

Level 4 subheading: in the indention section select: Left 1.8” and Hanging By 0.3.” 

Level 5 subheading: in the indention section select: Left 2.1” and Hanging By 0.3.” 

 

Repeat the process for every chapter in your Table of Contents. 
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BLOCK QUOTATIONS 
 

Do not use spacing or tabs for block quotations. Follow these instructions to set a block 

quotation: 

1.   Select the text you want to quote in block. 

2. From the Home tab, open the Paragraph dialog box. 

3. Click on the Indents and Spacing if it is not on the top. 

4. In the Indention section, in the Left box type 0.5.” 

5.   In the Spacing section, under the Line Spacing select Single. 

6. Click OK. Your block quotation is set. 

Remember to double space before and after block quotations. 
 

 

FOOTNOTES 
 

Inserting Footnotes - In order to insert footnotes into your document follow these 

guidelines: 

1. Position the cursor in the place where you want your footnote number to appear. 

2. Click on the References tab. 

3. In the Footnotes section, open the Footnote & Endnote dialog box. 

4. In Location, select Footnotes & Bottom of Page. 

5. In Format section, select Number from 1, 2, 3, …(if not already selected). 

6. Click Insert. Type the text of the footnote. Backspace one to delete space after foot-

note number (if necessary). Repeat the process for each footnote. 
 

Modifying Footnotes Style 

In order to create the same style for all footnotes: 

1. After entering first footnote notation, place cursor immediately after footnote             

number. 

2. Right click the mouse. 

3. A new box will open.  Select Style. 

4. The Style box will open with Footnote Text selected. 

5. Click on the Modify button (see the picture on the right). 

6. The Modify Style box will open. Select the font type and size to be the same as the 

       main text of your document.   

2. Next, click Format button and select paragraph. 

3. A Paragraph box will open.  Select indention: First line by 0.5.” Under Spacing   

      After, set to 12 pt. Click OK. Click OK again. Click Apply. 

 

Your footnote style is set. When you enter new footnote notations they will always be 

the same size, font type and the first line will be indented 0.5.” 
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Removing Footnote Continuation Separator 

 In order to remove footnote separator that is going all the way across the page do the 

following: 

1.  Click on the View tab and select Draft in the Document View section. 

2. Next, click the References tab and, in the Footnotes section, select Show Notes.  

The page should split into two sections with footnotes being displayed in the bot-

tom section. 

3. In the bottom section, where it says Footnotes, select Footnote Separator; the 

short horizontal line will appear. 

4. Select this short line and on the keyboard click Ctrl + C (copy). 

5. Go to Footnote Continuation Separator. 

6. Select this longer line and on the keyboard click Ctrl + V (paste). 

7.  Your Footnote Separator and Footnote Continuation Separator should be the 

same length. 

8.  Click Show Notes again to close the footnotes  section of the page. 

 
 

BIBLIOGRAPHY 

 

Do not use spacing and tabs to format your bibliography.  Instead, use hanging    

      indents (see the instruction in Hanging Indents of Heading). 

Select all bibliography and format hanging indents as shown on the picture 

(Indention: Left and Right 0,” Special—Hanging, By—0.5;” Spacing—Single). 

Make sure the spacing after selection is set to 12 pt. 

Double space between books and periodicals listed in the bibliography. 

Triple space between headings. 

Page number on the first page of the bibliography should appear centered at the        

bottom. 

Page number on following pages goes 1” from top and right margins 

In order to format numbers, follow the instructions for Page Numbering. 
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ORU Library Resources 

Research is formalized curiosity.  

It is poking and prying with a purpose. 
 

—Zora Neale Hurston 
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ORU LIBRARY RESOURCES 

ACCESS TO ORU LIBRARY DATABASES  

Many of ORU's electronic resources are available via the Internet.  Since your bibliogra-

phy should include journal articles as well as books, you will find ORU’s databases very 

helpful in doing your research. Many databases store journal articles from thousands of 

journals and magazines either in full text or abstract form. Some databases contain the 

text of full length books. The use of ORU databases is restricted to ORU students and 

faculty.  

 

When ORU Is Your Internet Provider:  

To access the ORU Library databases, log onto the OR network with your Novell user 

name and password. Then, go to the ORU Library Web Page (www.oru.edu/university/

library).  Select a resource such as the library catalog, the journal list, or another elec-

tronic resource, and begin searching.  

 

Via Another Internet Provider:  
Go to the ORU Library Web Page (www.oru.edu/university/library).  Click on "Off-

Campus Access" in the listing in the top section of the right frame.  A login page will 

pop up. 

 

Fill in your Novell user name.  Your user name is usually the same as your ORU stu-

dent e-mail address less the @oru.edu.  For example, if your e-mail address is 

gil26456@oru.edu, then your user name is gil26456.  If you have forgotten your ORU e

-mail address, go to https://vision.oru.edu and key in your student ID number and pass-

word as instructed.  Once in Vision, click on "Personal Information," then click "View 

E-mail Addresses."  

 

Fill in your Novell password. If you need help with your password, contact the Stu-

dent IT Help Desk at (918) 495-6321, or email iservices@oru.edu.   

 

After you have filled out your user name and password, the ORU library web 

page will open again.   (When you log on successfully, the "Off Campus Access" link 

is gone.)  You are now ready to select the library catalog, the Journals List, the Data-

base List, or Central Search and begin searching. 

 

 

 

 

http://www.oru.edu/university/library
http://www.oru.edu/university/library
https://vision.oru.edu
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JOURNAL SEARCH USING DATABASES  

 

Topical Search in Journals  

You may use ORU’s databases to search 

through the theological journals for a par-

ticular subject, keyword, Scripture, name, 

etc.  To start searching, open the library’s 

main page and click on Database List (you 

will find it in the left menu).  

 

Once the Database List opens, scroll down 

the page to find EBSCOhost Databases 

(All). Click it. When the new page opens, 

click EBSCOhost Research Databases. 

Now, check the boxes beside the databases 

you want to search. Theological databases include ATLA Religion Database with AT-

LASerials, New Testament Abstracts, and Old Testament Abstracts. Others are also 

available. You may wish to check Academic Search Complete as it indexes a significant 

number of theological journals. Once you have checked the desired databases, click 

Continue.  
 

After the above window opens, you may begin your search.  In the search box, type the 

subject or name that you desire to search.  If desired, you may limit your search by se-

lecting a particular field (e.g., title or author) or by using a limiter such as a range of 

dates.  

 

 

ATLA Database Search  

In the above search, four databases were selected, allowing you to search all four data-

bases simultaneously.  However, sometimes it is better to search within just one data-

base (particularly ATLA, which is the largest theological database) because you can do 

specific kinds of searching such as Scripture searching which are not available when 

searching a combination of databases.  

 

In order to search in the ATLA Database only, click the Choose Databases link above 

the search boxes. When the list of databases appears, select only ATLA Religion Data-

base with ATLASerials.  Along the blue tool bar at the top of the screen, you will see 

several options including Publications, Scriptures, and Indexes.  

Select one to search.  If you are interested in finding articles on a particular Bible pas-

sage, for example, click Scriptures. A new page will open with a list of passages. In the 

Browse box, enter the passage that you want to find.  A list of references will open.  Se-

lect one or more by putting a check mark in the boxes of the ones that pertain to your 
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search.  Click Search. A list of citations to journal articles and essays related to the se-

lected passages will appear.  

You may also do a search for a particular sub-

ject.  To do this, click on the Indexes link on 

the blue tool bar. Then in the Browse an index 

box, select Subjects All. In Browse for, enter 

the subject that you want to find. Click Browse. 

A list of sub­jects will open.  Select one or 

more that relates to your interest and click 

Search.  A list of citations to journal articles 

related to the selected subject will appear. 

Search for a Particular Journal Article 

You may also search for a particular journal 

article using the ORU databases.  For example, if while reading and researching, you 

find a reference to a particular journal article and you want to read the full article, use 

the type of search described here to find the desired resources: To start the search, go to 

the main page of the library, and click Journals List in the left-hand menu.  In the 

search box, type the exact name of the journal that you want to find (for example, Jour-

nal of Biblical Literature).  Click Search.  A new page will open with a list of results.  

On the results page displayed in the image on the right, there are two types of findings 

for the search for Journal of Biblical Literature: (1) the ORU Library Catalog and (2) 

three online databases, ATLA Religion Database with ATLASerials, Academic Search 

Complete, and Humanities International Complete. (Be sure to note the date range be-

side each database. In this case the ATLA database has from 1943 to the present, 

whereas the other two have 1973 to the present.) 

 

 The ORU library catalog link leads you to the catalog entries of the journal holdings 

that are in paper, microfilm, and/or CD-ROM format.  When you click the holdings link, 

the library catalog opens and takes you to two records related to Journal of Biblical Lit-

erature. The icons indicate the available formats: paper and microform. 

 

In the Journals List example in the image at the top of the page, three databases are 

listed which contain articles from Journal of Biblical 

Literature.  Click the name of a database that contains 

the date of the article that you are looking for (for ex-

ample, Academic Search Complete).  A new page with 

years of publication will open (see image to the right).  

Click the desired year, and then the desired volume 

and issue.  

 

 



 42 

 

BOOK SEARCH USING THE LIBRARY CATALOG  

You can search through the books and audiovisual materials available at the ORU li-

brary using the ORU online catalog.  Go to the main library web page. In the left col-

umn, select ORU Library Catalogs, and then ORU Library Catalog. The page that 

opens is the library catalog. 

Now you can begin your search.  In the Search box, select your desired method of 

searching.  For example, you can search the library's resources by title, author, subject, 

or call number, etc.  Then, in the box to the right, enter a word or phrase appropriate to 

the index that you selected. Click Submit.  

 

A new page will open with the results of your search 

(see image on the right). Click on a relevant result. A 

new page will open with a list of items available. 

Scroll through the list. When you find a title that 

looks appropriate, click it for more information. If 

you decide you want the book, write down the title, 

call number, and location in the library so you will 

know where to find it on the shelf.   

 

Note: To go backwards and forwards in the results list, it is best to use Results List link 

provided in the catalog rather than the browser back button.  

 

 

CENTRAL SEARCH 

The library has a powerful resource called Central Search that allows simultaneous 

searching of virtually all the library databases.  

Databases that are specifically theologi-

cal in nature are not the only ones that 

contain religious or biblical materials; 

many multidisciplinary databases (e.g. 

Academic Search Complete) do as well. 

To identify which databases may have 

material relevant to your particular topic, 

go to the library home page and click 

Central Search. Then click Search by 

subject, and then click the box beside 

the word Theology. Now, in one of the 

search boxes, key in a keyword or phrase, and click Search. 

The results page will indicate the number of items found by each vendor (e.g., EBSCO-

host). To see the results within individual databases, click the plus sign beside the name 

of each of the vendors.  
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CENTRAL SEARCH  continued 

Each of the databases that has results will have a number beside it. Click the name of the 

database to see the results in it. Begin scanning the results. When you find the title of a 

relevant item, click the title. You will be immediately taken to its record. If the full text 

of the item is available in that database, you will be able to click on a link to it. The full 

text is either in PDF or HTML format.   

 

THESIS AND DISSERTATION SEARCH  

Another kind of resource that you may find useful in your 

research are theses, dissertations, and applied research 

projects. These are searchable in the library catalog or in 

the databases.  

 

Library Catalog.  To search the Library Catalog for a 

project or dissertation, go to the Advanced Search page 

(see instructions Book Search using Library Catalog) and 

select Subject from the arrow-down box. Then in the first search box, type Research 

Projects, Applied, then select or in the drop-down box, and then select Subject again, 

and type Dissertations, Academic. Click Submit.  A new page will open showing the 

total number of projects and dissertations in the library (see image on the right).  Scroll 

the search. They will include works from other academic institutions that are in the 

ORU library, in addition to projects and theses by ORU students. 

 

WorldCatDissertations Database.  In order to access the WorldCatDissertations data-

base, on the main page of the library, click on Databases.  The Databases by Title page 

will open. Click the last entry on the list, WorldCatDissertations. The WorldCatDis-

sertations Advanced Search page will open (see the image on the left). To find informa-

tion on a specific title, do a keyword search for the author’s last name and two or three 

keywords from the title.  

To search for theses in a general subject area, click the Subjects icon on the far left of 

the gray tool bar (as seen on the image 

on the right). Type your topic of interest.  

Click Search.  Then scan the list for ti-

tles of interest.  
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REFERENCE RESOURCES  

Numerous reference resources in the ORU Library may be used for theological or bibli-

cal research. Several of these are described below:  

 

Bible dictionaries and Bible encyclopedias 

To find general history or background information on persons, places, customs, subjects 

etc., use Bible dictionaries and Bible encyclopedias.  

LRC-R indicates that the item is shelved in the Reference area. 

NetLibrary, Ebrary or Credo indicates that the item is an electronic book avail-

able online (search for the title in the library catalog and click the link).  

Otherwise, items are available in the Main Collection. Examples: 

  

A Dictionary of the Bible - BS440.B73 2004 LRC-R 

Baker Encyclopedia of the Bible - BS440.B26 1988 LRC-R 

Baker Theological Dictionary of the Bible - BS440.E78 2000 LRC-R 

Biblical Studies on the Internet: A Resource Guide - Ebrary 

Biographical Dictionary of Christian Theologians - Ebrary  

Blackwell Encyclopedia of Modern Christian Thought - BR95 .B58 1995 LRC-R 

Britannica Encyclopedia of World Religions - Ebrary 

Companion Encyclopedia of Theology - Ebrary  

Critical Terms for Religious Studies – Credo  

Dictionary of the Bible - BS440.H5 1988 LRC-R 

Dictionary of Christian Biography - BR1700.3.D53 2001 LRC-R 

Dictionary of Early Christian Beliefs - BR66.5.D53 1998 LRC-R 

Dictionary of Early Christian Literature - BR66.5 .L4813 2000 LRC-R 

Dictionary of Ethics, Theology & Society - ebrary (online); BJ63 D53 1996 LRC-R 

Dictionary of Mission: Theology, History, Perspect. - BV2040.L4813 1997 LRC-R 

Dictionary of Pastoral Care and Counseling - BV4011.D43B 1990 LRC-R 

Eerdmans Dictionary of the Bible - BS440.E44 2000 LRC-R 

Encyclopaedia Judaica - DS102.8.E496B LRC-R (Look up your topic in the 

Index, vol. 1.)  Also available online via the library Database List. 

Evangelical Dictionary of Christian Education - BV1461.E93 2001 LRC-R 

Evangelical Dictionary of World Missions - BV2040.E92 2000 LRC-R 

Handbook of Contemporary Preaching - BV4222.H35 1992 

HarperCollins Bible Dictionary - BS440.H235 1996 LRC-R 

Holman Bible Dictionary - BS440.H69 1991 LRC-R 

Illustrated Bible Dictionary - BS440.D6x 1980 Vol. 1-2 LRC-R 

International Standard Bible Encyclopaedia - BS440.I6 1994 LRC-R 

Interpreter’s Dictionary of the Bible - BS440.I63 1962 Vol. 1-4 LRC-R 

The Jewish Religion: A Companion - NetLibrary 

Macmillan Dictionary of the Bible - Credo  

Mercer Dictionary of the Bible - BS440.M429 1990 LRC-R 

http://site.ebrary.com/lib/oru/Doc?id=10315717
http://site.ebrary.com/lib/oru/docDetail.action?docID=10017993
http://site.ebrary.com/lib/oru/Doc?id=10270741
http://site.ebrary.com/lib/oru/Doc?id=10057583
http://www.credoreference.com.ezproxy.oru.edu:2048/book/uchicagors
http://infotrac.galegroup.com.ezproxy.oru.edu:2048/itweb/oru?db=GVRL
http://www.netlibrary.com/urlapi.asp?action=summary&v=1&bookid=27422
http://www.credoreference.com.ezproxy.oru.edu:2048/book/macdbib
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Bible dictionaries and Bible encyclopedias continued 

 

New Bible Dictionary - BS440.D734 1996 LRC-R 

New Catholic Encyclopedia - BX841.N44 2003 Vol. 1-15 LRC-R 

New Dictionary of Christian Ethics and Pastoral Theo-BJ1199.N495 1995 LRC-R 

The New Encyclopedia of Judaism – Credo  

The Oxford Dictionary of the Bible - BS440 .B73 2004 LRC-R 

Oxford Dictionary of the Christian Church - BR95.O8 1997 LRC-R 

Oxford Dictionary of World Religions - BL31.O84 1997 LRC-R 

Prime-Time Religion: An Encyclopedia of Religious Broadcasting - Ebrary  

Who’s Who in Christianity - Credo  

Who's Who in the New Testament  - Credo  

Who's Who in the Old Testament - Credo  

World Christian Encyclopedia - BR157.W67 2001 Vol. 1-2 LRC-R 

World Religions - BL31.W67 1998 LRC-R 

Wycliffe Bible Encyclopedia - BS440.W92 1975 Vol. 1-2 LRC-R 

Zondervan Pictorial Encyclopedia of the Bible - BS440.Z63 1975 Vol. 1-5 LRC-R 

  

Concordances 

To find a particular Bible verse when you know a key word, use concordances.  

Call number section BS425. Examples:  

The New Strong's Expanded Exhaustive Concordance of the Bible 
       BS425.S8 2001 LRC-R  

       Contains Hebrew and Greek dictionaries to help you find terms.  

The NIV Exhaustive Concordance - BS425.G62 LRC-R  

       Contains Hebrew to English Index-Lexicon, Greek to English Index-Lexicon,  

       and Index of Strong’s/Goodrick Kohlberger numbers.  

New American Standard Exhaustive Concordance of the Bible  
       BS425.N385 LRC-R  

BibleGateway.com - available on the Internet. Allows searching of a number of    

            English versions of the Bible as well as several other language translations. 

 

Specialized dictionaries, English 

For in-depth research on a particular English word, see specialized dictionaries.  

Examples:  

The Anchor Bible Dictionary - BS440.A54 LRC-R 

The Complete Biblical Library (Harris) - BS2535.2.N474 LRC-R 

 Includes three sections: Harmony of the Gospels, N.T. Study Bible with  

 Interlinear Bible, and Greek-English Dictionary. 

Complete Word Study Dictionary - PA881.Z63 LRC-R (Use the English index in  

 the front of the book.)  

Dictionary of New Testament Theology (Brown) - BS2397.N48 LRC-R  

Theological Dictionary of the Old Testament - BS440.B5713 1974- LRC-R 

http://www.credoreference.com.ezproxy.oru.edu:2048/book/nyupencyjud
http://site.ebrary.com/lib/oru/Doc?id=10015394
http://www.credoreference.com.ezproxy.oru.edu:2048/book/routwwchr
http://www.credoreference.com.ezproxy.oru.edu:2048/book/routwwnt
http://www.credoreference.com.ezproxy.oru.edu:2048/book/routwwot
file:///C:/Documents%20and%20Settings/sshelton/Desktop/biblegateway.com
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Specialized dictionaries, English  continued 
 

Theological Dictionary of the New Testament, PA881.K513 1964- LRC-R 

Vine’s Expository Dictionary of Biblical Words, BS537.E967 LRC-R  

Vine’s Expository Dictionary of Old & New Testament Words, BS440.V748 LRC-R  

 

 

Commentaries 

For in-depth research on a particular word, Bible verse, social and cultural milieu, etc., 

see commentaries. General call numbers section is BS490 through 491.5. Other com-

mentaries are under call number according to the book of the Bible they discuss. Exam-

ples:  

Collegeville Bible Commentary - BS491.2.C66 1989 LRC-R  

Eerdmans Commentary on the Bible - BS491.3.E37 2003 LRC-R 

The Expositor’s Bible Commentary - BS491.2 .E96  

HarperCollins Bible Commentary - BS491.2.H37 2000 LRC-R 

Harper’s Bible Commentary - BS491.2.N4 1988 LRC-R 

New Bible Commentary - BS491.2.N45 1994 LRC-R 

The New Jerome Biblical Commentary - BS491.2.N485 1990 LRC-R 

The New Interpreter’s Bible - BS491.2 .N484 1994 LRC-R  

 

Commentaries often come in series. Some are shelved together, while others are not. To 

find a commentary of a particular book of the Bible in a particular series, do an ad-

vanced keyword search in the library catalog for the series title and for the name of the 

book of the Bible as a keyword (e.g. “Title”: Berit Olam AND “Keyword”: Ruth ). Ex-

amples of series are: 

 

Abingdon New Testament Commentaries – LRC-R 

The Anchor Bible (“Bible. English.Anchor Bible. 1964”)  

 BS192.2.A1 1964.G3 (First Corinthians available online via Ebrary) 

Augsburg Commentary on the New Testament – LRC-R 

The Berit Olam series on the Old Testament – BS1295.2 .H35 2000 

Black’s New Testament Commentaries - BS2341.B56 LRC-R 

International Critical Commentary- BS491.I6 LRC-R 

International Theological Commentary - BS1151.2.I57 LRC 4th Floor 

Interpretation - BS491.2.I54 LRC-R (some vols. available online via NetLibrary) 

New International Biblical Commentary - BS2341.2.N48 LRC-R 

New International Commentary on the Old Testament - BS1151.2.N4 LRC-R 

New International Commentary on the New Testament - BS2341.2.B7 LRC-R 

The NIV Application Commentary - BS491.2.N58 LRC-R 

The Old Testament Library - BS1151.2.O4 LRC-R 

The Sacra Pagina series on the New Testament - BS2341.2.S22 LRC-R 

Word Biblical Commentary - BS491.2.W67 LRC-R 

 

http://site.ebrary.com/lib/oru/Doc?id=10315717
http://webopac.oru.edu/search~S13/?searchtype=h&searcharg=Interpretation%2C+a+Bible+commentary+for+teaching+an&searchscope=4&sortdropdown=-&SORT=D&extended=0&SUBMIT=Search&searchlimits=&searchorigarg=hInterpretation%2C+a+Bible+commentary+for+teaching+an
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Interlinear Bibles 

For a translation and/or transliteration of ‘Hebrew’ or ‘Greek’ see Interlinear Bibles.  

 

  

 

Specialized dictionaries (Hebrew and Greek)   

For research on a particular Hebrew or Greek word, use specialized dictionaries, parsing 

guides, and lexicons.   

 

 
 

 

Parsing guides and analytical keys 

 

 
 

 

 

Greek Hebrew

The Interlinear Hebrew-Greek-English Bible   The Interlinear Hebrew-Greek-English Bible

      (Green, BS1 1976)       (Green, BS1 1976)

The Interlinear Greek-English New Testament The Interlinear Bible, Hebrew/English

 (Marshall, BS1965 1959B)       (Green, BS715 1976X)

The R.S.V. Interlinear Greek-English New Tes­The NIV Interlinear Hebrew-English Old Testa-

       tament (BS1965 1970)       ment  (Kohlenberger, BS715 1979)

The Complete Biblical Library, “N .T. Study

      Bible" (Harris, BS2535.2.N474, v. 2-10)

Greek Hebrew

Dictionary of New Testament Theology Theological Dictionary of the Old Testament

      (Brown, BS2397.N48)       (Botterwick, BS440.B5713)

Theological Dictionary of the New Testament Theological Wordbook of the Old Testament

      (Kittel, PA881.K513)       (Harris, Archer, Waltke; BS440.T49)

Theological Lexicon of the New Testament Students Hebrew and Chaldee Dictionary

      (PA875.S613)        (PJ4833.H1914)

The Complete Word Study Dictionary (N.T.) Gesenius' Hebrew-Chaldee Lexicon to the Old

      (PA881.Z63)       Testament  (PJ4833.G41979)

The Complete Biblical Library,  (Harris, New International Dictionary of Old Testament

      BS2535.2.N474) Greek-English Diction-       Theology and Exegesis  (BS440.N438) Vol. 5

      ary, v. 11-16       has Scripture, subject, & numbering index.

Greek Hebrew

A Parsing Guide to the Greek New Testament Old Testament Parsing Guide

      (PA847.H3)       (PJ4645.B43)

The Complete Biblical Library Analytical Key to the Old Testament  (4 vols.)

      (Harris, BS2535.2.N474)       (Owens, PJ4731.B53 O94)
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Lexicons 

 
 

 

OTHER LIBRARY RESOURCES  

eBooks:  Do an advanced search in the catalog, using netlibrary or ebrary as a key-

word and a term such as missions or theology as a keyword.  Or go to the eBooks page 

(from the Library page, find the Read about eBooks) and follow the directions there.  

Note that all 8,800+ of the netLibary eBooks that ORU owns are searched simultane-

ously when you do a full text search from the netlibrary site. Similarly, the full text of 

46,000+ eBooks is searched when you do a simple search from the ebrary site.   

Table of Contents:  One way to keep informed of what is being currently published in 

theology is to browse the tables of contents of related journals in FirstSearch's Elec-

tronic Collections Online (ECO).  On the ECO page, click "Browse Journal Titles" and 

then, from the "All Subject Collections," select a category under "Philosophy. Psychol-

ogy [B-BJ]" or "Religion & Religions [BL-BX]."  Begin browsing.  Please note: ECO 

provides only a small amount of full text.  

 

Other Formats:  Do a subject keyword search in webPAC. On the results list page, 

click a subject. In the page that opens, scroll down the list scanning entries for format 

icons. If the list is long, you may limit it to a particular format by selecting a format 

from the drop-down box (see picture on the left). Available format limits include 

audiobooks, audio cassettes, DVDs, and ebooks. After making a selection, click Search. 

The results will be limited to the selected format. 

 

Library Guides:  

Click on Library Guides from the Library home page, and scroll down the page to see 

the theology-related guides: Theology Resources; Theology/Bible Word Studies; Theo-

logical Reference Materials; Locating an Essay in the ATLA Religion Database; For-

eign Countries, Cultures & Missions; Babylonian Talmud.  

 

 

 

Greek Hebrew

Theological Lexicon of the New Testament Old Testament Word Studies  (BS1125.W52) Use

      (PA875.S613, multi-volume set)       as a lexicon and concordance.

A Greek-English Lexicon of the New Testa- Hebrew and English Lexicon of the Old Testa-

      ment  (Bauer, PA881.B38)       ment  (Brown, PJ4833.G4 1836)

Analytical Greek Lexicon  (PA881.A6) Analytical Hebrew and Chaldee Lexicon

      (PJ4833.D3)

The New Brown, Driver, Briggs, Gesenius 

      Hebrew & English Lexicon  (PJ4833.B66)

Index to BDB Hebrew Lexicon  (PJ4833.B683)



 49 

 

Library Tutorials: 

The Library’s instruction librarian has created three new interactive tutorials that cover a 

variety of topics and research skills that will help you be a successful student. These 

online tutorials, available on the Library’s home page, will allow you to learn at your 

own pace.  

 

Choose a tutorial appropriate for your level of skill and knowledge. If you are 

new to the University, begin with the "Library Orientation” for an introduction to 

the Library’s services, resources, and physical and electronic environments. 

"Research Basics" will explain how to begin a research project and give tips and 

tools for strategic searching, evaluating information, and avoiding plagiarism. If 

you live more than an hour away from the ORU campus, then begin with the 

“Distance Learners” tutorial, which will help you find out how the ORU Library 

can serve you even when you cannot be on campus.   

 

Special Collections 

The ORU Theology Collection is located on the 4th floor of the LRC, primarily within the 

BJ-BX call number range. These books may be checked out. 

The Reference Library has a comprehensive collection of theological resources, to be used 

only in the library. 

The Holy Spirit Research Center, LRC, 5th floor 

One of the largest and most comprehensive Pentecostal/charismatic and Holy 

Spirit collections in the world, it contains over 12,000 books, 300 magazines, 

4,500 tapes, vertical files of tracks, pamphlets, brochures, unpublished pa-

pers, newsletter, and new articles, and hundreds of sound recordings, films, 

photographs, and microfilms. 

Contact Dr. Mark Roberts, Director, for hours:  918-495-6899, or 

hsrc@oru.edu . 

 

The following special collections are accessed by permission through the Circulation 

Desk.  A key to the collection room may be checked out for a maximum of four hours. 

William Sanford LaSor Collection, LRC 408 E-F 

Elmar Camillo Dos Santos Collection (with collection below) LRC 408 L-M 

Jewish Theological Seminary Collection, LRC 408 L-M 

Temple Israel Library has a long-standing agreement to allow ORU students to 

check out their materials. You may visit the Temple library any time during normal 

business hours.  For research assistance, see library committee, Tuesday mornings.  

Search library catalog at  http://titulsa.surpasssoftware.com/titulsa/ 

Temple Israel, 2004 East 22nd Place, Tulsa, Oklahoma 74114-2800 Adminis-

trative Office: (918) 747-1309 

mailto:hsrc@oru.edu
http://titulsa.surpasssoftware.com/titulsa/
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Online Jewish research sources 

Babylonian Talmud Research Guide (ORU Library):    

http://webapps.oru.edu/new_php/library/guides/talmud.html 

Jewish Encyclopedia: http://www.jewishencyclopedia.com/index.jsp 

Jewish National and University Library (JNUL) Digitized Book Repository 

http://www.jnul.huji.ac.il/eng/digibook.html 

Rare and out-of-print monographs 

About 1,100 digitalized volumes, from 15th century incunabula to early 20th 

century works. 

Judaism:   

            http://www.oru.edu/university/library/Elites/heologicalresources.html#JUD 

RAMBI : Index to articles and books on Jewish studies by the Jewish Na-

tional and University Libraries.  http://jnul.huji.ac.il/rambi/ 

The Talmud (Yale University Library):   http://www.library.yale.edu/

cataloging/hebraicateam/talmud.htm 

WebShas–Index to the Talmud:  http://www.webshas.org/ 

 

 

Note: This page was adapted from various sections of the ORU Library’s website 

(http://www.oru.edu/university/library).  

 

(Library section rev. 6/2/10 S.S.) 

 

http://webapps.oru.edu/new_php/library/guides/talmud.html
http://www.jewishencyclopedia.com/index.jsp
http://www.jnul.huji.ac.il/eng/digibook.html
http://www.oru.edu/university/library/Elites/theologicalresources.html#JUD
http://jnul.huji.ac.il/rambi/
http://www.library.yale.edu/cataloging/hebraicateam/talmud.htm
http://www.library.yale.edu/cataloging/hebraicateam/talmud.htm
http://www.webshas.org/
http://www.oru.edu/university/library
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Bibliographic Examples 

Learn as much by writing as by reading. 
 

—Lord Acton 
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FOOTNOTE AND BIBLIOGRAPHIC EXAMPLES 

 

Turabian style is required for the bibliography and footnotes.  Refer to Turabian chap-

ters 16-17 for the general samples of style.  This manual deals with the bibliographical 

entries that are most commonly used by theological students in the seminary.  

Use the standard 12-point font for footnotes and bibliography. 

When referencing a specific publisher, refer to the publisher exactly the same way in 

all notes and bibliographic entries. 

Never use a title in a note of bibliographic entry (Rabbi, Rev., Dr.) 

Never use degrees in a note of bibliographic entry (BA, MA, PhD) 

In the examples below, the first entry is for a footnote; the second for a bibliography. 

 

 

MULTIVOLUME WORKS 

1. One author, several volumes: 
1R. Laird Harris, ed, “,ma,” Theological Wordbook of the Old Testament, vol. 1 

(Chicago: Moody Press, 1980), 51. 

 

Harris, R. Laird, ed. “,ma.”Theological Wordbook of the Old Testament. Vol. 1.  

 Chicago: Moody Press, 1980. 51-53. 

. 

2. One author, several volumes, translated: 
2Adolf Harnack, History of Dogma, vol. 2, trans. Neil Buchanan (London: Wil-

liams and Norgate, 1910), 120. 

 

Harnack, Adolf. History of Dogma. Vol. 2. Translated by Neil Buchanan. London: Wil-

liams and Norgate, 1910. 
 

3Hecataeus, Aegyptiaca 11.3-4, in Greek and Latin Authors on Jews and Juda-

ism, vol. 1, From Herodotus to Plutarch, trans. F. R. Walton, ed. Menahem Stern 

(Jerusalem: The Israel Academy of Sciences and Humanities, 1974), 28. 

 

Hecataeus, Aegyptiaca. In Greek and Latin Authors on Jews and Judaism. Vol. 1, From 

Herodotus to Plutarch. Translated by F.R. Walton. Edited by Menahem Stern. 

Jerusalem: The Israel Academy of Sciences and Humanities, 1974. 20-46. 
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3. One author, different title of each volume: 
4Justo Gonzalez, The Story of Christianity, vol. 2, The Reformation to the          

Present Day (Peabody, MA: Prince Press, 1985), 57. 

 

Gonzalez, Justo. The Story of Christianity. Vol. 2, The Reformation to the Present Day. 

Peabody, MA: Prince Press, 1985. 

 

 

4.  Independent Titles and Different Authors for Each Volume: 
5Brian Rapske, The Book of Acts and Paul in Roman Custody, vol. 4, The Book 

of Acts in Its First Century Setting, ed. Bruce W. Winter (Carlisle, UK: Paternoster, 

1994), 26. 

 

Rapske, Brian. The Book of Acts and Paul in Roman Custody. Vol. 4, The Book of Acts 

in Its First Century Setting. Edited by Bruce W. Winter. Carlisle, UK: Paternos-

ter, 1994. 

 

 

5.  Multiple authors with the same name (Jr., Sr., III): 
 6Rogers, Cleon L. Jr. and Cleon Rogers III.  The New Linguistic and Exegetical 

Key to the Greek New Testament.  Grant Rapids: Zondervan, 1998. 

 

Rogers, Cleon L. Jr. and Cleon L. Rogers III.  The New Linguistic and Exegetical Key to  

 the Greek New Testament.  Grant Rapids: Zondervan, 1998. 

 

BIBLE COMMENTARIES (In Bibliography, list under Books) 

1. Author given, no volume number: 
1John B. Polhill, Acts, New American Commentary (Nashville: Broadman, 

1992), 160. 

 

Polhill, John B. Acts. New American Commentary. Nashville: Broadman, 1992. 

 

 

2. Author and volume number given:  
2Edward R. Campbell, Ruth, Anchor Bible, vol. 7 (Garden City, NY: Doubleday, 

1975), 27. 

 

Campbell, Edward R. Ruth. Anchor Bible. Vol. 7. Garden City, NY: Doubleday, 1975. 
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3. Several volumes by the same author: 

(Note: abbreviated names/initials are only acceptable when the full name is not cited in 

the original and is unknown.  See example below.) 
3F. Delitzsch, Biblical Commentary on the Book of Job, Part 2, Biblical Com-

mentary on the Old Testament, vol. 2, trans. Francis Bolton  (Grand Rapids: Eerdmans, 

1949), 115. 

 

Delitzsch, F. Biblical Commentary on the Book of Job. Part 2. Biblical Commentary on 

the Old Testament. Vol. 2. Translated by Francis Bolton. Grand Rapids:              

Eerdmans, 1949. 
 

 

4. Commentary as a part of the volume in a multivolume set:  
4Fred B. Craddock, “The Letter to the Hebrews: Introduction, Commentary, and 

Reflections,” New Interpreter’s Bible, vol. 12 (Nashville: Abingdon, 1998), 54. 

 

Craddock, Fred B. “The Letter to the Hebrews: Introduction, Commentary, and          

Reflections.” New Interpreters Bible. Vol. 12. Nashville: Abingdon, 1998. 
 

 

5. Editor or Compiler as “Author”: 
5Edward Hastings, ed., The Speaker’s Bible, vol. 15 (Grand Rapids: Baker, 

1971), 123. 

 

Hastings, Edward, ed. The Speaker’s Bible. Vol. 15. Grand Rapids: Baker, 1971. 
 

 

ARTICLES IN THEOLOGICAL DICTIONARIES AND ENCYCLOPEDIAS  

In Bibliography, list under Books. 

In the footnote, indicate the page(s) of the particular reference cited. 

In the bibliographic entry, list the entire pagination of the article. 

A separate full entry is needed for each individual article from any one book. 
 

1. Signed article: 
1Hayim Lapin, “Rabbi,” Anchor Bible Dictionary, vol. 5, ed. David Noel          

Freedman (New York: Doubleday, 1992), 601. 

 

Lapin, Hayim. “Rabbi.” Anchor Bible Dictionary. Vol. 5. Edited by David Noel           

Freedman. New York: Doubleday, 1992. 600-602. 
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2J. Fredrick McCurdy, “covenant,” The Jewish Encyclopedia, vol. 4, ed. Isidore 

Singer (New York: KTAV Publishing House, 1964), 318. 

 

McCurdy, J. Fredrick. “Covenant.” The Jewish Encyclopedia. Vol. 4.  Edited by Isidore 

Singer. New York: KTAV Publishing House, 1964. 318-322. 

 

 

2. Unsigned articles: 

Dictionary/Encyclopedia articles without separate authors for each article: 
 

3Ronald F. Youngblood, ed., “angel,” Nelson’s New Illustrated Bible Dictionary, 

rev. ed. (Nashville: Nelson, 1995), 15. 

 

Youngblood, Ronald F., ed. “Angel.” Nelson’s New Illustrated Bible Dictionary. Rev. 

ed. Nashville: Nelson, 1995. 15-16.  
 

 
4John D. Davis, “baptism,” The Westminster Dictionary of the Bible, vol. 1 

(Philadelphia: The Westminster Press, 1944), 59. 

 

Davis, John D. “Baptism.” The Westminster Dictionary of the Bible. Vol. 1.                      

Philadelphia: The Westminster Press, 1944. 59. 
 

 

3. Concordances:  List bibliographic entries for each individual word and a full foot-

note entry for first reference to each word in text. 
 

5Robert Young, “heavens,” Analytical Concordance to the Bible, 22nd American 

ed. (Grand Rapids: Eerdmans, 1970), 472. 

 

Young, Robert. “Heavens.” Analytical Concordance to the Bible. 22nd American ed.  

 Grand Rapids: Eerdmans, 1970. 472. 
 

 

 6James Strong, “ouvranovV,” A Concise Dictionary of the Words in the Greek  

Testament,” in The New Strong’s Exhaustive Concordance of the Bible (Nashville: Tho-

mas Nelson, 1990), 53. 

 

Strong, James. “ouvranovV.” “A Concise Dictionary of the Words in the Greek  

 Testament.” In The New Strong’s Exhaustive Concordance of the Bible.  

 Nashville: Thomas Nelson, 1990. 53.  
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4. Lexicons:  List bibliographic entries for each individual word and a full footnote 

entry for first reference to each word in text. 
 

 7Walter Bauer, “ouvranovV,” A Greek-English Lexicon of the New Testament and 

Other Early Christian Literature, trans. and adapt. William F. Arndt and F. Wilburg 

Gingrich, 4th rev. and aug. ed. (Chicago: University of Chicago, 1952), 599.  

 

Bauer, Walter. “ouvranovV.” A Greek-English Lexicon of the New Testament and Other 

Early Christian Literature. Translated and adapted by William F. Arndt and F. 

Wilburg Gingrich. 4th rev. and aug. ed. Chicago: University of Chicago, 1952. 

598-600. 
 

 
8Francis Brown, C. Briggs, and S. R. Driver, “ymv,” The Brown-Driver-Briggs 

Hebrew and English Lexicon (Peabody, MA: Hendrickson Publishers, 1996), 1029. 

 

Brown, Francis, C. Briggs, and S. R. Driver. “ymv.” The Brown-Driver-Briggs Hebrew 

 and English Lexicon. Peabody, MA: Hendrickson Publishers, 1996. 1029. 
 

 

PERIODICALS 

In the footnote, indicate the page(s) of the particular material cited in your text. 

In the bibliographic entry, list the entire pagination of the article. 

 

1. Journals with successive pagination throughout the different issues: 
1Ruth Lienhard, “A ‘Good Conscience’: Differences Between Honor and Justice 

Orientation,” Missiology 29 (2001): 132. 

 

Lienhard, Ruth. “A ‘Good Conscience’: Differences Between Honor and Justice Orien-

tation.” Missiology 29 (2001): 131-141. 

 

 

2. Journals with separate pagination for each issue: 
2Cartright C. Bellworthy, “Reform of Congressional Remuneration,” Political 

Review 7, no. 6 (1990): 89, 93-94. 

 

Bellworthy, Cartright C. “Reform of Congressional Remuneration.” Political Review 7, 

no. 6 (1990): 89-94. 
 

 
3Richard Jackson, “Running Down the Up-Escalator: Regional Inequality in 

Papua New Guinea,” Australian Geographer 14 (May 1979): 180. 
 

Jackson, Richard. “Running Down the Up-Escalator: Regional Inequality in Papua New 

Guinea.” Australian Geographer 14 (May 1979): 175-84. 

http://www.christianbook.com/Christian/Books/search?author=C.%20Briggs&detailed_search=1&action=Search
http://www.christianbook.com/Christian/Books/search?author=S.R.%20Driver&detailed_search=1&action=Search
http://www.christianbook.com/Christian/Books/search?author=C.%20Briggs&detailed_search=1&action=Search
http://www.christianbook.com/Christian/Books/search?author=S.R.%20Driver&detailed_search=1&action=Search
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ANCIENT WRITERS 

1. Church Fathers/Ante-Nicene Fathers/Nicene and Post-Nicene Fathers: 
1Irenaeus, Against Heresies 5.5.1 (ANF 1:530). 

 

Irenaeus. Against Heresies, 5.5.1. In vol. 1 of The Ante Nicene Fathers. Edited by Alex-

ander Roberts and James Donaldson, 1885. Reprint, Peabody, MA: Hendrickson, 

1995. 
 

 

 2Origen, On First Principles, trans. G. W. Butterworth (Gloucester, MA: Peter 

Smith, 1973), Book I, Preface, Section 8. 

 

Origen. On First Principles. Translated by G. W. Butterworth. Gloucester, MA: Peter 

Smith, 1973.  
 

 

3John Chrysostom, Interpretatio Omnium Epistularum, ed. F. Field (Oxford: 

Claredon, 1849-1862), 10; quoted in Mark J. Edwards, ed., Ancient Christian Commen-

tary on Scripture: New Testament, vol. 8 (Downers Grove, IL: InterVarsity, 1999), 306. 
 

Chrysostom, John. Interpretatio Omnium Epistularum. Edited by F. Field. Oxford: 

Claredon, 1849-1862. 10. Quoted in Mark J. Edwards, ed. Ancient Christian 

Commentary on Scripture: New Testament. Vol. 8. 306. Downers Grove, IL: 

InterVarsity, 1999.  
 

 

 4The Clementine Homilies 1.3 (ANF 8:223). 
 

The Clementine Homilies 1.3. In vol. 8 of The Ante-Nicene Fathers.  Edited by Alexan-

der Roberts and James Donaldson, 1887. Reprint, Peabody, MA: Hendrickson, 

1994.   
 

 

 5Augustine, Letters of St. Augustin 28.3.5 (NPNF 1:252). 
 

Augustine. The Letters of St. Augustin 28.3.5. In vol. 1 of The Nicene and Post-Nicene 

Fathers, no. 1. Edited by Philip Schaff, 1886. Reprint, Peabody, MA:                  

Hendrickson, 1994. 
 

 

2. Classical authors: 
6Flavius Josephus, Jewish War, in The Works of Josephus, vol. 4, ed. William 

Whiston (New York: Oakley, Mason, 1869), 85. 

 

Josephus, Flavius. Jewish War. In vol. 4 of The Works of Josephus. Edited by William 

Whiston. New York: Oakley, Mason, 1869. 
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3. Rabbinical or Jewish writings:   
 

7Judah David Eisenstein, “Sabbatical Year and Jubilee,” The Jewish                        

Encyclopedia, vol. 10, ed. Isidore Singer (New York: Funk and Wagnalls, 1905), 605. 
 

Eisenstein, Judah David.  “Sabbatical Year and Jubilee.” The Jewish Encyclopedia. Vol. 

 10. Edited by Isidore Singer. New York: Funk and Wagnalls 1905. 605-608. 
 

 
8Marcus Jastrow, ed., “fm1v2,” A Dictionary of the Targumim, the Talmud Babli 

and Yerushalmi, and the Midrashic Literature, vol. 2 (Brooklyn, NY: P. Shalom Pub., 

1967), 1595. 
 

Jastrow, Marcus, ed. “fm1v 2.”  A Dictionary of the Targumim, the Talmud Babli and  

 Yerushalmi, and the Midrashic Literature. Vol. 2. Brooklyn, NY: P. Shalom  

 Pub. Inc., 1967. 1595. 
 
 

9Mishnah Sanhedrin 10:2. 
 

The Mishnah. Translated by Herbert Danby. London: Oxford University Press, 1933. 
 

 

 10The Mishnah: A New Translation, trans. Jacob Neusner (New Haven,  

CT: Yale University Press, 1988). 
 

The Mishnah: A New Translation.  Translated by Jacob Neusner.  New Haven, CT: Yale 

University Press, 1988. 
 
 

11B. Talmud Sanhedrin 97a. 
 

The Babylonian Talmud. Edited by I. Epstein. London: Soncino, 1935. 
 

 
12Nahum M. Sarna, Deuteronomy, The JPS Torah Commentary: The Traditional 

Hebrew Text with the New JPS Translation (Philadelphia: The Jewish Publication Soci-

ety, 1991), 169. 
 

Sarna, Nahum M. Deuteronomy. The JPS Torah Commentary: The Traditional Hebrew  

 Text with the New JPS Translation. Philadelphia: The Jewish Publication  

 Society, 1991. 
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Rabbinical or Jewish writings:  continued   
13Song of Songs Rabbah 7.7.1 (Midrash Rabbah 9:289).  

 

Song of Songs. Translated by Maurice Simon. In vol. 9 of Midrash Rabbah. Edited by  

 H. Freeman and Maurice Simon. 3rd ed. New York: The Soncino Press, 1983.  
 

 

 14Tosefta Kiddushin 1:12. 

 

The Tosefta. Vol. 1. Translated by Jacob Neusner. Peabody, MA: Hendrickson  

 Publishers, 2002. 
 

 

ELECTRONIC DOCUMENTS 
 

Important Note: Electronic/online references should be verifiable, academic 

sources. If a website’s reliability is in question, students need to consult their professor 

for approval. 

Web entries are to be no more than 1/3 of the total bibliographic sources. 

While the web provides numerous sites and is easily accessible, it is best to use it as 

a secondary source of information rather than the primary (see chapter 3 in Vyhmeister 

for further guidance on web sources). 

Place in the following bibliographic categories: 

Database entries should normally be placed under Periodicals (or other    

appropriate category heading). 

E-Books should be placed under Books. 

CD-Rom references put with appropriate section, e.g., Periodicals, Books 

Pure Web-Entries should be placed under Other Sources 

Other web entries should be placed under appropriate category heading. 

 Important: With sites containing web addresses, the first date in the 

footnote and bibliographic entries should refer to the creation, revi-

sion, or last update of the article/information being cited. 

 The second date in the footnote and bibliographic entries refers to the 

day the site was accessed. In a professional site, the name in italics 

that precedes the article date is the name of the web site. 
 

1. Journal article from a database: 
1Carl Graesser, “Righteousness, Human and Divine,” Currents in Theology and 

Missions 10 (1983): 135. ATLA Religion Database, EBSCOhost (22 July 2003). 
 

Graesser, Carl. “Righteousness, Human and Divine.” Currents in Theology and              

Missions 10 (1983): 134-141. ATLA Religion Database, EBSCOhost (22 July 

2003). 
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Journal article from a database  continued 
 

2John T. Pawlinowski, “Christian Anti-Semitism: Past History, Present Chal-

lenges,” Journal of Religion and Society 6 (2004): 2, http://mses.creighton.edu/

JRS/2004/2004-20.html; quoted in David F. Sandmel, “The Christian Reclamation of 

Judaism,” Judaism 54 (2005): 255, n. 1. ATLA Religion Database, EBSCOhost (23 Sep-

tember 2007). 

 

Pawlinowski John T. “Christian Anti-Semitism: Past History, Present Challenges,” 

Journal of Religion and Society 6 (2004): 2. http://mses.creighton.edu/

JRS/2004/2004-20.html. Quoted in David Fox Sandmel, “The Christian Recla-

mation of Judaism.” Judaism 54 (2005): 251, n. 1. ATLA Religion Database, 

EBSCOhost (23 September 2007). 
 

 

2. Reference article from a database: 
3Lavina Cohn-Sherbok,  “John of Damascus (c.675-c.749),”  Who’s Who in  

Christianity (Routledge, 2002),  n. p., Credo Reference Database, Ezproxy (11 Septem-

ber 2010). 

 

Cohn-Sherbok, Lavina.  “John of Damascus (c.675-c.749).”  Who’s Who in Christianity.  

Routledge, 2002.  N. p. Credo Reference Database, Ezproxy (11 September 

2010). 
 

 

3. Journal article from online journal (ejournal): 
4Tonya Browning, “Embedded Visuals: Student Design in Web Spaces,” Kairos: 

A Journal for Teachers of Writing in Webbed Environments 3, no. 1 (1997): n.p., http://

english.ttu.edu/kairos/2.1/features/browning/index.html (22 July 2003). 

 

Browning, Tonya. “Embedded Visuals: Student Design in Web Spaces.” Kairos: A 

Journal for Teachers of Writing in Webbed Environments 3, no. 1 (1997): n.p. 

http://english.ttu.edu/kairos/2.1/features/browning/index.html (22 July 2003). 
 

 

4. Article in an electronic magazine (ezine): 
5Nathan Myhrvold, “Confessions of a Cybershaman,” Slate, 12 June 1997, n. p., 

http://slate.msn.com/id/1904/ (22 July 2003). 

 

Myhrvold, Nathan. “Confessions of a Cybershaman.” Slate. 12 June 1997. N. p. http://

slate.msn.com/id/1904/ (22 July 2003). 
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5. Online book: 
6Peter J. Bryant, “History of Life on Earth,” in Biodiversity and Conservation, 

April 1999, n.p., http://darwin.bio.uci.edu/~sustain/bio65/lec01/b65lec01.htm (22 July 

2003). 

 

Bryant, Peter J. “History of Life on Earth.” In Biodiversity and Conservation. April 

1999. N. p. http://darwin.bio.uci.edu/~sustain/bio65/lec01/b65lec01.htm (22 July 

2003). 

 

 

6. E-Books  
7Louis P. Pojman and Jeffery Reiman, The Death Penalty: For and Against  

(Lanham, MD: Rowman and Littlefield, 1998), 34-36 (E-book accessed on 24 October 

2000, from NetLibrary database). 

 

Pojman, Louis P. and Jeffery Reiman. The Death Penalty: For and Against. Lanham, 

 MD: Rowman and Littlefield, 1998. E-book accessed on 24 October 2000, from  

 NetLibrary database. 

 

 

7. Electronic Books: Kindle, Microsoft Reader, Nook, etc. (see Chicago Manual of 

Style [CMS] 14.166-169) 

Indicate a format other than print at the end of the citation. 

If page numbers are not included in the electronic format, include an indication of 

chapter or section or other locator.  (See CMS 14.17) 
 

8Phyllis Trible, God and the Rhetoric of Sexuality (Philadelphia: Fortress, 1978), 

Kindle Electronic Edition: Chapter 4, Location 288-90.   

 

Trible, Phyllis. God and the Rhetoric of Sexuality. Philadelphia: Fortress, 1978. Kindle  

 Electronic Edition: Chapter 4, Location 288-90.   
 

 

Note different formats of same book: 
 

Austin, Jane. Pride and Prejudice. New York: Penguin Classics, 2007. Kindle edition. 

Austin, Jane. Pride and Prejudice. New York: Penguin Classics, 2007. PDF e-book. 

Austin, Jane. Pride and Prejudice. New York: Penguin Classics, 2007. Microsoft  

 Reader e-book. 
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8. Book and Journals in print now on the Internet:  

 9John Gill, “John Ch 1,” Exposition of the Whole Bible, on Freegrace.net. n. d.,  

http://www.freegrace.net/gill/ (26 May 2009).  

 

Gill, John. “John Ch 1.” Exposition of the Whole Bible. On Freegrace.net. N. d.  

 http://www.freegrace.net/gill/ (26 May 2009).  
 

 
10Bruce K. Waltke, “Righteousness in Proverbs,” Westminster Theological  

Journal 70 (2008): 227, http://www.wts.edu/uploads/images/files/70.2.Waltke. Right-

eousness%20in%20 Proverbs.pdf (26 May 2009).  

 

Waltke, Bruce K. “Righteousness in Proverbs.” Westminster Theological Journal 70  

 (2008): 225-237. http://www.wts.edu/uploads/images/files70.2.Waltke.  

 Righteousness%20in%20 Proverbs.pdf (26 May 2009). 
 

 

9. CD-ROM reference with a corresponding print edition: 
11Duane F. Watson, “False Apostles,” n. p., The Anchor Bible Dictionary on CD-

ROM, Logos Library System Version 2.0c. 1995, 1996. 

 

Watson, Duane F. “False Apostles.”  N. p. The Anchor Bible Dictionary on CD-ROM. 

Logos Library System Version 2.0c. 1995, 1996. Print ed.: David Noel Freed-

man, ed. Anchor Bible Dictionary. Vol. 2. New York: Doubleday, 1992. 760-

761. 
 

 

10. CD-ROM Reference 

 12Ludwig Koehler, Walter Baumgartner, M. E. J. Richardson, and Johan Jakob 

Stamm, “rbj,” n. p., The Hebrew and Aramaic Lexicon of the Old Testament on CD-

Rom. Logos Library System Version 4.3SR-6. 2011. 

 

Koehler, Ludwig, Walter Baumgartner, M. E. J. Richardson, and Johan Jakob Stamm.  

 “rbj.” N. p. The Hebrew and Aramaic Lexicon of the Old Testament on         

 CD-Rom. Logos Library System Version 4.3 SR-6. 2011. 
 

 

11. Personal website: 
12Jeff Lamp, “Jeff Lamp's Stuff and All Page,” 16 July 2003, http://www. 

gbronline. com/jlamp/ (22 July 2003). 

 

Lamp, Jeff. “Jeff Lamp's Stuff and All Page.” 16 July 2003. http://www.gbronline.com/

jlamp/ (22 July 2003). 
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12. Professional website: 
13John Dart, “Up Against Caesar,” Society of Biblical Literature, SBL Online, 8 

February 2005, http://www.sbl-site.org/Article.aspx?ArticleId=388 (11 July 2005). 

 

Dart, John. “Up Against Caesar.” Society of Biblical Literature. SBL Online. 8 February 

2005. http://www.sbl-site.org/Article.aspx?ArticleId=388 (11 July 2005). 
 

 

 14R. A. Torrey, “anointing,” n. p., The New Topical Textbook, 1897,  

Biblestudytools.com, 2010, http://www.biblestudytools.com/concordances/torreys- 

topical-textbook/anointing.html (29 January 2010). 

 

Torrey, R. A. “Anointing.” N. p. The New Topical Textbook. 1897. Biblestudytools.com.  

 2010. http://www.biblestudytools.com/concordances/torreys-topical-textbook/

anointing.html (29 January 2010). 
 

 

13. E-mail: 

 15Richard McBrien (rmcbrien@nd.edu), Reply to Query Regarding Catherine 

LaCugna,  e-mail to Sally Shelton (sshelton@oru.edu) (16 February 2004). 

 

McBrien, Richard (rmcbrien@nd.edu). Reply to Query Regarding Catherine LaCugna.  

E-mail to Sally Shelton (sshelton@oru.edu) (16 February 2004). 
 

 

MISCELLANEOUS  

1. Article in a Study Bible or book 

 1James Caroll Tollett, “The Holy Spirit at Work [Exodus],” in New Spirit-Filled 

Life Bible, gen. ed. Jack Hayford (Nashville: Thomas Nelson, 2002), 76. 

 

Tollett, James Caroll.  “The Holy Spirit at Work [Exodus].”  In New Spirit-Filled Life  

 Bible, gen. ed. Jack Hayford, 76. Nashville: Thomas Nelson, 2002. 
 

 

2. Secondary source of quotation:  (The “4, n. 16” in the reference below refers to 

page 4, “note” 16 in that source) (See other example under Journal Article from a Data-

base.) 
2M. L. Peel, “Theological Education in America,” Vox Theologica 33 (1962-63): 

85; quoted in Jacob Firet, Dynamics in Pastoring (Grand Rapids: Eerdmans, 1986), 4, n. 

16.  
 

Peel, M. L. “Theological Education in America.” Vox Theologica 33 (1962-63): 85. 

Quoted in Jacob Firet, Dynamics in Pastoring, 4, n. 16. Grand Rapids:  

 Eerdmans, 1986. 

http://www.sbl-site.org/
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3. Class papers: 
3Wojtek Panas, “The Righteousness of God in Romans,” a paper presented for 

GBIB 517 Paul: Mission & Message, Oral Roberts University, November 2002, 10. 

 

Panas, Wojtek. “The Righteousness of God in Romans.” A paper presented for GBIB 

517 Paul: Mission & Message, Oral Roberts University, November 2002. 
 

 

4. Class notes (lectures): 

 4Larry Hart, “Azusa Street,” class notes from GTHE 663 Charismatic Theology, 

Oral Roberts University, October 2004. 

 

Hart, Larry. “Azusa Street.” Class notes from GTHE 663 Charismatic Theology, Oral 

Roberts University, October 2004. 
 

 

5. Class handout composed by professor:  

 5Ann Young, “Flashbacks: What Helps,” class handout from PRM 627 Crisis 

Counseling, Oral Roberts University, January 1998. 

 

Young, Ann. “Flashbacks: What Helps.” Class handout from PRM 627 Crisis  

 Counseling, Oral Roberts University, January 1998.   
 

 

6. Reprint: 
6John L. Nevius, Demon Possession (New York: Fleming H. Revell, 1894; re-

print, Grand Rapids: Kregel, 1968), 274. 

 

Nevius, John L. Demon Possession. New York: Fleming H. Revell, 1894. Reprint, 

Grand Rapids: Kregel, 1968. 
 

 

7. Component part by one author in a work edited by another: 
7Richard M. Davidson, “Headship, Submission, and Equality in Scripture,” in 

Women in Ministry: Biblical and Historical Perspectives, ed. Nancy Vyhmeister 

(Berrien Springs, MI: Andrews University Press, 1998), 266. 

 

Davidson, Richard M. “Headship, Submission, and Equality in Scripture.” In Women in 

Ministry: Biblical and Historical Perspectives, ed. Nancy Vyhmeister, 259-295.  

Berrien Springs, MI: Andrews University Press, 1998. 
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8. Footnote with multiple entries:  

 8Walter R. Martin, Kingdom of the Cults (Minneapolis: Bethany Fellowship, 

1977), 172; Ruth A. Tucker, Another Gospel (Grand Rapids: Zondervan, 1989), 75; and 

Ron Rhodes, The Challenge of the Cults and New Religions (Grand Rapids: Zondervan, 

2001), 59. 

 

 

9. Archived sources: 
 9Senethea Meyer, “Historical Notes of Eugene Bible College” (Eugene, OR: 

Eugene Bible College, 2004, library archives), 2. 

 

Meyer, Senethea. “Historical Notes of Eugene Bible College.” Eugene, OR: Eugene  

 Bible College, 2004. Library archives, 1-6. 

 

 

10. Interview: 

 10Choo Lak Yeow, Executive Director of the Association for Theological Educa-

tion in Southeast Asia, interview by author, Singapore, 15 July 1985. 

 

Yeow, Choo Lak, Executive Director of Association for Theological Education in 

Southeast Asia. Interview by author. Singapore. 15 July 1985.  

 

 

11. Newspapers: 
11Tim Talevich, “Eugene Bible College Earns Accreditation,” The Register-

Guard, 26 November 1983, sec. C, p. 11. 

 

Talevich, Tim. “Eugene Bible College Earns Accreditation.” The Register-Guard, 26 

November 1983, sec. C, p. 11. 

 

 

12. Applied Research Project/Dissertation/Thesis:  
12Carol Peters Tanksley, “Decreasing Anxiety Through Training in Spiritual 

Warfare,” (D. Min. proj., Oral Roberts University, 2009), 25. 

 

Tanksley, Carol Peters. “Decreasing Anxiety Through Training in Spiritual Warfare.” 

D. Min. proj., Oral Roberts University, 2009.  
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13. Subsequent Reference Examples (for footnotes only): 

If more than one citation to a particular source appears in the work, subsequent    

references to that source need only to be noted in a shortened form. This applies to 

most all referenced materials. 

The shortened citation usually contains the author’s last name (unless others have 

the same name) and page number. 

If different works are cited that were written by the same author, the title of the work 

must also be included. 

The order then would be the author’s last name, title, and page number. 

Works with no author need to only list the title and page number. 

Make sure when citing books, the title is always italicized. 

When referencing the title of an article or similar type of reference, place the name 

of the title in “quotes.” 

 

BOOKS 

1. Only one book cited by author: 

 1Bloesch, 12.  
 

 

2. One book by more than one author:  

 2Fee and Stuart, 33. 
 

 

3. Two books by the same author: 

 3Bloesch, The Evangelical Renaissance, 12. 

 4Bloesch, The Invaded Church, 56. 
 

 

4. Kindle books 

 5Trible, Kindle ed.: chap. 4, loc. 288-90. 
 

 

JOURNALS/MAGAZINES 

1. One article cited by author: 

 1Moore, 79.  

 

2. One article by more than one author:  

 2Uzzi and Spiro, 2.    
 

 

http://205.143.139.58/ipac20/ipac.jsp?session=1U21B966549L8.13&profile=pub1&uri=search=TL~!The%20evangelical%20renaissance,&term=The%20evangelical%20renaissance,&aspect=basic_search&menu=search&source=~!oru
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3. Two articles by the same author with successive pagination: 
 

 3Mercadante, “Are We All Immigrants?” 3-4. (cite all pages used) 

4Mercadante, “Winners or Whiners?” 16. (For journals, magazines, articles, etc. 

list the title of the article rather than the title of periodical it came from, if the same au-

thor is cited for two different articles.) 
  

Examples are transferable to most all other types of referenced materials. 
 

Note: If an example of a particular source cannot be found in this manual or in  

Turabian, consult your professor for assistance. 
 

The above samples of style were adapted from Vyhmeister ch. 10, Turabian ch. 17, 

and SBL Handbook of Style ch. 7. 
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Example Pages 

Reading maketh a full man,  

conference a ready man,  

and writing an exact man. 
 

—Sir Francis Bacon 
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DISCLAIMER 

 

 

 

The beliefs and conclusions presented in this thesis are not necessarily those of the ad-
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or the faculty. 
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 ABSTRACT 

 

 

 

Name of student, Master of Arts in Your Degree 

 

Title of your thesis; do not underline; single space the second line 

 

Full name of supervising professor, Ph.D. 
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 CHAPTER 1 

 

EUGENE BIBLE COLLEGE:  

BORN OUT OF REVIVAL 

 

 

 

Introduction 

  

 Clearly one of the most distinctive points of time in the history of the church is 

the Pentecostal outpouring that came like a flood in the early part of the twentieth cen-

tury. William J. Seymour was the dominant figure in this historic event . . . 

 

Azusa Street 

 

 The Azusa Street Revival significantly shaped and impacted the Pentecostal 

churches of America in the early part of the twentieth century. . . . 

 

Theological Implications 

 

 From a theological standpoint, many of these early Pentecostals sought to follow 

a literal interpretation of scripture. . . . 

 

Spirit Baptism    

  

 Their biblical understanding of Spirit baptism was that of an experience separate  

 

from sanctification. . . . 

  

  

 Fulfillment of Joel 2:28-32. They felt they were amidst a literal fulfillment of  
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 Although the debate between the cultic/figurative and the literal interpretation  

 

continues, there is no doubt that Malachi calls for faithfulness between husbands and  

  

wives because marriage is grounded in the covenant between the husband and wife and  

Yahweh.1  However, the traditional view identifies marriage as a covenant and one of  

 

the most important scholars to support this view is Gordon Paul Hugenberger. In his  

 

book, Marriage as a Covenant, he presents a thoroughly researched study in biblical  

 

ethics especially in the concept of marriage as held by Malachi and other Bible writers.  

 

Hugenberger argues that Malachi 2:14 refers to a literal marriage covenant and not to a  

 

figurative one as some scholars believe. Malachi 2:14 reads: 

 

   |t6yr3B5 tv6a4w5 |T5r5b6j* ayh3w5 HB2 hT2d5g1B2 hT2a rv6a*   

                         yr6Oen5 tv6a4 ,yb4O |n5yB4 dye3h4 hw2hy5-yK3 le1 hm2-le1 .T6r5m1a*w1 
 

And you say wherefore? Because the Lord has been a witness between you and 

the wife of your youth, against whom you have been faithless, though she is your 

companion and your wife by covenant.2 

 

Hugenberger argues that the endearing designation “the wife of your youth” in 2:14 is in 

 parallel with “the wife of your covenant.” This implies that the covenant in 2: 14 was 

 between the husband and wife.3  In Genesis 31:50, the reference of the . . .  

 

 

 

 1Ralph L. Smith, Malachi, Word Biblical Commentary, vol. 32 (Waco: Word, 

1984), 325. 

 2Author’s translation. 

  3Gordon Paul Hugenberger, Marriage as Covenant: Biblical Law and Ethic as 

Developed from Malachi (Grand Rapids: Baker, 1994), 28. 
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. . group there was no change. Rather, in question 6, there was a decrease of 3 points  

 

(average -7 as shown in Table 2).  

Table 2. Change of Faith Through Youth Group  

 

 

Triple space between the bottom of the table and the first line of the remainder of the  

 

text. Continue with the text as normal. 

 

NOTE: 

The number and title for a table is to be placed at the top of the table and left        

justified. (See Turabian, 26.2.2) 

All tables must have narration to introduce or conclude the table.  The narration for a 

table comes before the table itself. 

Turabian has a rather comprehensive list and approach to tables and figures in chap-

ter 8.  Please consult this material for further instructions. 

 

 

 

 

  
  

Pre-test Post-test Change Average  

Increase (%) 

  T.G C.G T.G C.G T.G C.G T.G C.G 

(5) God-centered Life 11 11 23 11 12 0 109 0 

(6) Jesus-like Character 13 13 23 13 10 0 76 0 

(7) Neighbor-Centered  11 14 21 11 10 -3 90 -21 

Total 35 38 67 35 32 -3 91 -7 
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APPENDIX A 

 

TITLE OF APPENDIX 

5” top margin  

Include this cover sheet in numbering,  

but do not put number on page 

See Turabian, Section 8 
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 EXAMPLES - BACK MATTER 

 

 
1. Bibliography, first page 

2. Bibliography second page 

3. Vitae 



 86 

 BIBLIOGRAPHY 

 

 

 

Books 

 

DiSante, Carmen.  Jewish Prayer: The Origins of Jewish Liturgy.  New York: Paulist  

 Press, 1985. 

 

Donin, Hayim Halevy.  To Pray as a Jew.  New York:  Basic Books, 1980. 

 

Elliger, K., and W. Rudolph. Biblia Hebraica Stuttgartensia. 4th ed. New York:  

 American Bible Society, 1990.  

 

Gonzalez, Justo. A History of Christian Thought. Vol. 3. Nashville: Abingdon, 1975. 

 

Harris, R. Laird, ed. “,ma.” Theological Wordbook of the Old Testament. Vol. 1.   

 Chicago: Moody Press, 1980. 51-53. 

 

________. “[a.” Theological Wordbook of the Old Testament. Vol. 1. Chicago: Moody 

Press, 1980. 137. 

 

________. “,wnj.” Theological Wordbook of the Old Testament. Vol. 1. Chicago:  

 Moody Press, 1980. 693. 

 
________. “dq.” Theological Wordbook of the Old Testament. Vol. 2. Chicago:  Moody 

Press, 1980. 786-787. 
 
________. “vdq.” Theological Wordbook of the Old Testament. Vol. 2. Chicago: 

 Moody Press, 1980. 786. 

 

Heinemann, J.  Prayer in the Talmud.  New York: DeGruyter, 1977.  

 

________. “The Background of Jesus’ Prayer.” In The Lord’s Prayer and Jewish  

 Liturgy. Edited by J. J. Petuchowski and M. Brocke, 205-210. New York:  

            Seabury, 1978.  

 

Hendrickson, William.  New Testament Commentary:  The Gospel of Matthew.   

 Edinburgh:  The Banner of Truth Trust, 1976. 

 

< Blank line 1 

< Blank line 2 

< Blank line 3 

< Subhead (line 4) 

A separate 

entry is  

made for 

each word 

referenced. 

8-spaced 

lined with 

period for 

second 

work of 

same  

author 

2” top margin  

65 
Page #  centered .75” from bottom. 

Continue numbering from main text. 

Left margin 1.5” 

Right and bottom margins 1” 



 87 

 

66 

Hertz, Joseph H.  The Authorized Daily Prayer Book. New York: Bloch Publishing,  

 1948. 

 

Jeremias, Joachim.  The Lord’s Prayer.  Philadelphia:  Fortress Press, 1964.   

 

Rapske, Brian. The Book of Acts in Its First Century Setting. Vol. 4, The Book of Acts 

and Paul in Roman Custody. Edited by Bruce W. Winter. Carlisle, UK:               

Paternoster, 1993. 

 

________. The Book of Act in Its Ancient Literary Setting. Grand Rapids: Eerdmans, 

1994. 

 

Renn, Stephen D., ed. “basileiva.” Expository Dictionary of Bible Words. Peabody,  

 MA: Hendrickson, 2005. 565. 

 

________. “epiouvsion.” Expository Dictionary of Bible Words. Peabody, MA:   

 Hendrickson, 2005. 235. 

 
________. “pater.” Expository Dictionary of Bible Words. Peabody, MA: Hendrickson, 

2005. 369. 

 

 

Periodicals 

 

Browning, Tonya. “Embedded Visuals: Student Design in Web Spaces.” Kairos: A 

Journal for Teachers of Writing in Webbed Environments 3, no. 1 (1997): n. p. 

http://english.ttu.edu/kairos/2.1/features/browning/index.html (22 July 2003). 

 

Moore, Art. “Does ‘The Gift of Salvation’ Sell Out the Reformation?” Christianity  

 Today, 27 April 1998, 17-18. 

 

Rhyne, C. Thomas. “Nomos Dikaiosynēs and the Meaning of Romans 10:4.” Catholic 

Biblical Quarterly 47 (1985): 486-499. 

 

 

Other Sources 

 

Shipley, Cory D. “Increasing Knowledge of Pastors and Church Leaders about Biblical  

 Church Discipline.” D. Min. proj., Oral Roberts University, 2009.  

Blank line 1 > 

Blank line 2 >  

Subhead line 3 > 

1.4” top margin  Left margin 1.5” 

Right and bottom margins 1” 

Second & successive page 

#s 1” from top & right 

Blank line 1 > 

Blank line 2 >  

Subhead line 3 > 



 88 

 VITA 

 

 

 

Elizabeth Marie Brown was born in Houston, Texas, on April 31, 1949, the daughter 

of Marie Joanna Brown and Peter Allen Brown. After completing her work at Lamar 

High School, Houston, Texas, in 1958, she entered Southwest Texas State Teachers 

College at San Marcos, Texas. During the summers of 1959 and 1960, she attended the 

University of Colorado. She received the degree of Bachelor of Science from Southwest 

Texas State Teachers College in May 1963. During the following years, she was em-

ployed as a biology teacher in the Austin High School. In September 1964, she entered 

The Graduate School of Business of the University of Texas. 

 

 

 

Permanent address: 1908 Oldham  

                                Austin, Texas 

 
 

2” top margin  

< Blank line 1 

< Blank line 2 

< Blank line 3 

< Blank line 1 

< Blank line 2 

< Blank line 3 

Left margin 1.5” 

Right and bottom margins 1” 

Vita has no page number 



 89 

 GREEK AND HEBREW TEXT CITATION EXAMPLES 

 
Greek Text Citation Sample 

 
Both Greek and English texts are indented half an inch from the left margin and        

single-spaced.  

Greek block quotes need to begin double-spaced after the text.  

The translation of the verse must begin double-spaced after the citation of the Greek 

text.  

At the end of the translation, double space between the translation and the start of 

the remainder of the main body of text.  

Both the Greek text block quote and translation need to be single-spaced.  

See example below: 

 

30 Тί οΰν έρουμεν; ότι έθνη τά μή διώκοντα δκαιοσύνην κατέλαβεν 

δικαιοσύνην, δικαιοσύνην δέ τήν έκ πίστεως, 31 ‘Іσραήλ δέ διώκων νόμον 

δικαιοσύνης είς όμον ούκ έφθασεν. 32 διά τί; ότί ούκ έκ πίστεως άλλ ώς έξ 

έργων. προσέκοφαν τώ λθω τοΰ προσκόμματος, 33 καθώς γέγραπται.  Ίδού 

τίθημι έν Σιών λίθον προσκόμματος καί πέτραν σκανδάλου, καί ό πιστεύων έπ 

αύτώ ού καταισχυνθήσεται.1 
 

30 What then shall we say? That Gentiles, who did not seek after righteousness, 

obtained righteousness, namely the righteousness which is based on faith. 31 But 

Israel, pursuing after a law of righteousness, did not attain that law. 32 Why not? 

Because it was not on the basis of faith, but as if it were based on works. They 

have stumbled over the stumbling stone, 33 as it is written, "See, I am laying in 

Zion a stone of stumbling, a rock of offense, and whoever believes in him will 

not be disappointed.2   

 

Paul begins this new section (Rom 9:30-31) with a paradoxical statement: Gentiles got 

 what they did not pursue (namely, righteousness), while the Jews did not obtain what  

they pursued (righteousness based on the law).  

 

 1All Greek references are from The Greek New Testament, 4th rev. ed., Barbara 

Aland, et al. (Stuttgart: United Bible Societies, 1994). 
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Hebrew Text Citation Sample 
 

Hebrew block quotes need to begin double-spaced after the previous text.  

Block quotes are single-spaced. 

Hebrew text is right justified. 

The English translation of the verse must begin double-spaced after the citation of 

the Hebrew text and will be single-spaced and indented 0.5 inches. 

At the end of the English translation, double space between the translation and the 

start of the remainder of the main body of text.  

See example below: 

 

This righteousness and wickedness referred, of course, only to the particular  

lawsuit and not to a general reputation of the litigants. This type of language is used for        

example in Deuteronomy 25:1-2: 

 :Oeyv3r5h3w5 qyD3X1h1-ta6 OqyDx5h3w5 .Ofp2v5O fp2v5M3h1-la6 OvG5n3w5 .yv3n2a* ,yB4 kyr3 hy6h5y3-yK3 
1rP2s5m3B5 yd4K5 wyn2p2l5 OhK2h3w5 fp4Ch1 WlyP3h3w5 ev2r2h2 tWKh1 ,B3-.a3 hy2h2w5 ev2r2h2-ta6  

When there is a strife between men and they go to the court, the judges will 

judge them, justifying the righteous and condemning the guilty. Then if the 

guilty man deserves to be beaten, the judge shall cause him to lie down and be 

beaten in his presence with a number of stripes in proportion to his offense.2 
   

In this case OqyDx5h1w5 (Hiphil of qdx) means, “declare to be righteous, or not guilty,”3  

and  Oeyv3d5h1w5  (also Hiphil, evd) means “condemn or declare to be guilty.”4 

 

 
1All Hebrew references are from Biblia Hebraica Stuttgartensia, 5th corrected 

ed. (Stuttgart: United Bible Societies, 1997). 

 
2Author’s translation. 

  
3Francis F. Brown, S. R. Driver, and Charles A. Briggs, “qdx,” The Brown-

Driver-Briggs Hebrew and English Lexicon (Peabody, MA: Hendrickson, 1996), 15.  

 
4Brown, Driver, and Briggs, “evd,” 25.  
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 Hebrew Text Citation Sample 

 

Hebrew block quotes need to begin double-spaced after the previous text.  

Block quotes are single-spaced. 

Hebrew text is right justified. 

The English translation of the verse must begin double-spaced after the citation of 

the Hebrew text and will be single-spaced and indented 0.5 inches. 

At the end of the English translation, double space between the translation and the 

start of the remainder of the main body of text.  

See example below: 

 

This righteousness and wickedness referred, of course, only to the particular  

lawsuit and not to a general reputation of the litigants. This type of language is used for        

example in Deuteronomy 25:1-2: 

 1
:Oeyv3r5h3w5 qyD3X1h1-ta6 OqyDx5h3w5 .Ofp2v5O fp2v5M3h1-la6 OvG5n3w5 .yv3n2a* ,yB4 kyr3 hy6h5y3-yK3 

1rP2s5m3B5 yd4K5 wyn2p2l5 OhK2h3w5 fp4Ch1 WlyP3h3w5 ev2r2h2 tWKh1 ,B3-.a3 hy2h2w5 ev2r2h2-ta6  

When there is a strife between men and they go to the court, the judges will 

judge them, justifying the righteous and condemning the guilty. Then if the 

guilty man deserves to be beaten, the judge shall cause him to lie down and be 

beaten in his presence with a number of stripes in proportion to his offense.2 
   

In this case OqyDx5h1w5 (Hiphil of qdx) means, “declare to be righteous, or not guilty,”3  

and  Oeyv3d5h1w5  (also Hiphil, evd) means “condemn or declare to be guilty.”4 

 

 
1All Hebrew references are from Biblia Hebraica Stuttgartensia, 5th ed. cor-

rected (Stuttgart: United Bible Societies, 1997). 

 
2Author’s translation. 

  
3Francis F. Brown, S. R. Driver, and Charles A. Briggs, “qdx,” The Brown-

Driver-Briggs Hebrew and English Lexicon (Peabody, MA: Hendrickson, 1996), 15.  
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Encouraging Scriptures 

The skill of  writing is to create a context  

in which other people can think. 
 

—Edwin Schlossberg 
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COMMON PROBLEMS WITH FORM AND STYLE 

 

Also see corresponding topics in Form and Style Section of this manual. 

 

Bibliography:  

Cites not matching footnotes, or contained in one place but not the other 

Only list sources used in text 

Problems with Bibliographic format—where to place sources within three                     

categories:  Books, Periodicals, or Other Sources. 

Separate entry not included for each word referenced in a concordance, lexicon, etc. 

Not using proper format 

 

Consistency:  Inconsistency throughout thesis (from chapter to chapter) with form and 

style. 

  

Contractions: Using contractions (contractions may not be used in academic papers). 

 

Ellipses:  No space between word and ellipsis; no space between dots of ellipses.   

 

Emphasis Added:   
Not using [emphasis added] when italicizing words/phrases in a quotation for emphasis; 

underlining or quotation marks are also options. 

 

First Pages:   
First pages of chapters/bibliography not done in proper format: 2” top margin, page 

number at bottom center, 3/4" from bottom of page; subsequent pages: 1.4” top margin, 

page numbers 1” from top and right margins.   

 

Footnotes:   

Not using proper format: 12 pt font; indent first line 0.5”;  single space footnotes; 

double space between footnotes. 

Footnote number and footnote on separate pages; indicated by footnote line all 

across bottom of page. 

Front Matter:  Not in proper format and not submitted with first chapter.   

 

Italics:  Not italicizing foreign transliterations (e.g., agape, shalom, koinonia, harpazo, 

etc.).  Do not italicize words/phrases in non-English alphabets (Greek or Hebrew).  

 

Names, Full:  Not using full names in first time use of quotes, then last name thereafter. 
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COMMON PROBLEMS WITH FORM & STYLE  continued 
 

Paragraph, introductory:  No introductory paragraph under each heading before 

breaking down into subheadings (must have at least two subheadings to break down)             

 

Paragraph, format:  Some paragraphs do not contain at least three sentences (try to 

avoid lengthy      sentences).   

 

Person:  Thesis not written completely in third person.  Do not use first person (“I,” 

“me,” “we,” or “us”) or second person (“you”).   

 

Punctuation:  Improper use of capitalization, commas, semicolons, parentheses, and 

ellipses. 

 

Quotations, block:  Not using block quotations for five or more lines of quoted text 

(and  foreign language quotes); (make liberal use of ellipses . . . only quote “heart of the 

matter”/central concept), or foreign quotations.   

 

Quotations:   

Not introducing all quotations. 

Using too much quoted material.  Ensure that copyright “Fair Use Rule” not                 

violated. 

 

Spacing:  Line spacing between headings and subheadings not formatted properly.   

 

Scripture reference: Not using general Scripture footnote at first Scripture reference, 

then parenthetically thereafter.   

 

Starting Sentences:  Starting a sentence with a number, quotation, or foreign word. 

 

Table of Contents:  Headings must match exact text of headings in body of thesis.   

 

Title:  Lines of title not in inverted pyramid format (for multiple line titles only).   

 

Widows and Orphans:  Subheading at bottom of page without at least two lines of text 

beneath to support it (or only one line at bottom of page starting a paragraph), or only 

one line at top of page ending a paragraph from the previous page.   
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SUBMITTING THESIS FOR FINAL APPROVAL 

 
 

Submit completed thesis to the Thesis Supervisor for the final approval.  Be sure the following 

requirements have been met before submission:    

Laser print 

General neatness and legibility; no liquid paper or visible corrections  

No footnote separators that span across the whole page 

No missing pages; pages in order; no upside down pages 

Margins:  

left 1.5”; right and bottom 1”  

top: first page of table of contents, chapters, and bibliography 2”; thereafter 1.4”  

Page numbers:  

On first page of new chapters and bibliography, centered 0.75” from bottom of page 

Following pages top right corner, 1” from top and right margins 

Text 

No subheadings on the last line on the page 

Subheading levels match the format of samples in the Thesis Manual  

Front pages are in the right order matching the format of samples in the Thesis Manual:  

Blank sheet  

Title page  

Disclaimer page  

Approval sheet  

Abstract  

Copyright 

Dedication (if used) 

Preface (if used) 

Acknowledgment page: small roman numeral “vi” (if Preface page not used) cen-

tered 0.75” at the bottom of the page  

Table of contents  

 Page numbers: small roman numerals centered at bottom of page 

 Chapters and headings with 0.3” indention and proper style 

 Page numbers of the chapters and subheadings correspond exactly with 

page numbers in the text of the document 

List of tables (if used) 

List of figures (if used) 

Appendix (if used) 

Main body of text 
Back pages are in the right order matching format of samples in the Thesis Manual: 

Bibliography – proper page numbering 

Vita – no page number 

Blank sheet  
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THESIS BINDING AND PUBLICATION CHECKLISTS 

 
After the Thesis Supervisor and the Faculty Reader have given their final approval of the thesis, 

submit copies to the Thesis Supervisor for binding and publication.  

 

Copy Information: 

The 2 copies required by the GSTM must be printed on 100% cotton paper  

Additional student copies may be printed on any good quality paper. 

Copies needed for Houchen Bindery: 

1 copy for ORU Library 

1 copy for STM 

1 copy for Faculty Reader (optional) 

Copies for student  

Copies needed for ProQuest 

1 copy for publication; this copy will be returned to the student (unbound). 

Include an extra copy of the Title Page and Abstract. 

 

 

To Submit Thesis for Binding by Houchen Bindery: 

 

All copies should be checked for accuracy:  all pages in proper order (see pp. 8-9 in  

this manual), no missing pages, all pages right side up, etc. 

All approval pages need to be signed and dated by the Thesis Supervisor and Faculty 

 Reader.   

Check with Thesis Supervisor for correct date to use on signature pages. 

Signatures must be in black ink. 

Include a blank sheet of 100% cotton paper on the front and back of each final copy. 

Submit copies for binding in a small box.
Submit a standard-sized manila file folder to the Thesis Supervisor which contains  

(for the STM academic office): 

1 copy of thesis Title Page 

1 copy of Abstract  

Completed form Requirements & Fees for M.A. Thesis (next page). Include: 

 Check/money order to Houchen Bindery for binding (see next page for prices) 

 Check/money order to ORU for postage (see next page for prices) 

 Your address/phone number/email—both present and after graduation, if known 

 Contact person/address/phone number, in the event we are unable to locate you 

within the next year 
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THESIS BINDING AND PUBLICATION CHECKLISTS  continued 
 

To Submit Thesis for Publication by ProQuest: (optional but recommended) 

 

ProQuest Publication Forms: 
See Thesis Supervisor to get required publication forms. 

Fill out and sign forms, indicating publishing/copyright options desired. 

Submit to Thesis Supervisor: 

All completed ProQuest publications forms 

Photocopy of forms for the academic office 

1 copy of thesis 

1 copy of signed approval page 

See Thesis Supervisor for correct date to use on signature page 

Signatures must be in black ink 

1 additional copy of title page and abstract for Proquest  

Check/money order to Proquest*  

Check/money order to ORU for postage* 

Completed Requirements & Feels for M.A. Thesis form (next page) 

 

 

 

*Note: The Requirements and Fees for M.A. Thesis form on the following page includes all fee 

information for Houchen Bindery, ProQuest, and postage. 



 97 

 

REREQUIREMENTS & FEES FOR M.A. THESIS 
ORU Graduate School of Theology and Ministry 

 

Copy or tear out this sheet and submit with payment to thesis supervisor. 
 

 

Name:___________________________________   Date:     ____________________________ 
 

Address: _____________________________________________________________________ 
 

Phone Number: __________________________   E-mail:  _____________________________  
 

Faculty Reader: _______________________________________________________________  
 

FEES CHARGED  A total of three checks will be required:  1) to ProQuest for publishing/

copyright; 2) to Houchen Bindery for binding; 3) to ORU for postage.  See details below: 
 

1. PUBLISHING (optional, unless requesting copyright):  

The student must sign a publishing agreement form.  (See Thesis Supervisor for forms)  

The copy of the Thesis or ARP Report sent to Proquest will not be bound and will be  

returned to the student unbound. The publishing process takes from 8 weeks to 6 months.   

Please indicate the method of returning the unbound copy:  

________Call phone number listed above.            ________Mail to address above. 

     Fees: 
________Master’s Thesis — Microfilms/Publishing .......................       $ 55.00 

________Microfilm Copy for the University (optional) ...................       $ 17.00 

________Copyright (optional)...... ....................................................       $ 55.00 

________Postage for mailing to PROQUEST (see postage below)… . .$   5.00 
Make check payable to PROQUEST................................Total Publishing: $___________ 
 

2. BINDING: 

Binding of each copy is $9.20 (up to 2” thick; over 2” is an additional $4.30/volume to 

be bound*) 

Include 1 copy for ORU Library, 1 copy for STM, (1 copy for Faculty Reader is        

optional)  

Any additional copies requested will be returned to the student. 

Please indicate preferred method of handling bound document(s):                                                                   

________For student pickup, call phone # above.    

      ________Mail bound copies to address above. 

The colors required by ORU are:  Binding (Royal Blue #588); Lettering (Gold).  

Indicate # of copies to be bound _____________ X $ 9.20 

Indicate # of copies to be bound _____________ X $13.50 (over 2” thick) 
              Make check payable to HOUCHEN BINDERY.......... Total Binding:  $____________       
 

3. POSTAGE: 

Postage for mailing thesis to ProQuest (see above)……..................................$  5.00 

Postage for mailing up to 4 copies of bound thesis to student......................... $  5.00 

For more than 4 copies mailed, additional  postage required ..........   $ ____  

If theses mailed internationally, additional postage required.............. $____  
Make check payable to ORU....................................    Total Postage: $___________________      

 

_____________________________________________          ________________________ 

Student Signature                                                                               Date 
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